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Tone Settings

Changing Ring Tones

You can set ring tones for incoming voice/video calls and email messages.
¢ You can also set ring tones individually for incoming calls/messages from contacts stored in FOMA handset
(Handset) Contact.—~ P102

Setting Ring Tones for Calls

| Default setting ‘ Voice call: Bells Video call: Harmonics Voicemail: Interlude

You can select a ring tone type for incoming voice/video calls as well as for new voicemails.

Tap $$ on the Application Selector bar, and tap Settings ¥ Tones
on the Menu bar

Voice call : Select a ring tone for incoming voice calls.

Video call : Select a ring tone for incoming video calls.

Voicemail : Select a ring tone when new voice message is
recorded.

2 Tap the field to set and select the ring tone

¢ Tap $$ to hear the selected ring tone.

3 Tap [Done]

The ring tone is set.
¢ Tap [Cancel] to cancel the ring tone setting.

NOTE

* When an incoming voice/video call is received from a caller stored in FOMA handset (Handset Contacts),
the ring tone assigned to the contact rings. However, if the caller does not send the Caller ID, the ring tone
assigned in this section rings instead.

* When you set Alert Mode to other than Audio, no ring tone rings.



Setting Ring Tones for Email

‘ Default setting ‘ Email: Random SMS: Bits_n_Bytes

You can select a type of ring tone for incoming SMS/email messages.

Tap $$ on the Application Selector bar, and tap Edit % Preferences
on the Menu bar

(Your subscribed email account ID)
: Select a ring tone for incoming email messages.
SMS : Select a ring tone for incoming SMS messages.

* |f you have stored multiple email accounts, all account IDs are
displayed.

2 Tap the field to set and select the ring tone

¢ Tap $$ to hear the selected ring tone.

3 Tap [Done]

The ring tone for incoming messages is set.
* Tap [Cancel] to cancel the ring tone setting.

NOTE

¢ When an incoming email/SMS message is received from a caller stored in Contacts (FOMA handset), the
ring tone assigned to the contact rings.
* When you set Alert Mode to other than Audio, no ring tone rings.

Ring Tone List

In your FOMA handset, the following ring tones for incoming calls/messages are preinstalled.
¢ You can install new ring tones for incoming calls/messages.

¢ File names that are too long to display end in "...".

1812_Overture.mid Interlude.mid

Alert.mid Mandolin_Concerto.mid
Also_Sprach_Zarathustra.mid Moonlight_Sonata.mid
Bells.mid Polonaise_in_A_Flat.mid
Big_Brass.mid Provincial.mid
Bits_n_Bytes.mid Random.mid

Blues.mid Rondo_ala_Turca.mid
Boogie_Swing.mid Snaggle.mid
Clair_de_Lune.mp3 Sonata_in_C.mid
Cosmic.mid Standard.mid
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Cumparsita.mid Symphony_in_G_Minor.mid
Ding.mid The_lslands.mp3
Door_Bell.mid Triads.mid
Flight_of_Bumblebee.mid Up_and_Down.mid
Harmonics.mid Wind_Chimes.mid

l Installing Melodies as Ring Tones l

To set downloaded melodies as ring tones for incoming calls/messages, you need to store the
melodies in Ringtune Manager as ring tones.

Tap $$ » $$ on the Application Selector bar, and tap General tab
®» Ringtune Manager tab on the Control panel screen

Ring tone
File size

Available space

Ringtune Manager
screen

2 Tap [Install]

Displays the name of the melody folder.

Displays melodies available for ring tones.
* Tap [Send] to send the ring tone via email or Bluetooth.
— P235, P261, P384

3 Tap the melody to store

The melody is selected.
e Tap Folder to select a folder.
¢ Tap a melody — $$ to hear the selected melody. Tap $$ to stop.

4 Tap [Select]

The melody is stored.
* Tap [Cancel] to cancel storing.



Deleting Ring Tones

You can delete a ring tone.

'I Tap the ring tone » [Delete] on the Ringtune Manager screen

* How to operate — P124

2 Tap [Yes]

Deletes the selected ring tone.
* Tap [No] to cancel deleting.

l Muting Ring Tones I

‘ Default setting | Alert Mode: Audible ‘
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When you set Alert Mode to Silent, your FOMA handset makes no ring tones for incoming calls/
messages.

'I Tap $$ on the Status bar, and tap $$ of Silent on the Alert mode
screen

The Alert Mode is set to Silent and $$ is displayed on the Status bar.
e Tap $$ of Vibrator to vibrate the FOMA handset for incoming calls/messages as you tap
$$ of Audio to ring the ring tones.

Adjust Volume

Adjusting the Volume for Ring Tones

Default setting u

You can adjust the volume of ring tones for incoming calls/messages to any of 8 levels.
You can also set the volume to silent mode.
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Tap $$ » $$ on the Application Selector bar, and tap the Handset
tab ®» Sound tab on the Control panel screen

2 Tap Ringer and select the volume

* You can select from 0 (Silent) to 8 (Maximum).

3 Tap [Done]

The ring tone volume is set.

Vibrator

Vibrating Your FOMA Handset for Incoming Calls or Alarm

| Default setting | Alert Mode: Audio

When you set Alert Mode to Vibrate, your FOMA handset vibrates to indicate incoming calls/

messages.

¢ Do not leave your FOMA handset on the desk when the vibrator is set. The FOMA handset may fall off when
it vibrates.

'I Tap $$ on the Status bar, and tap $$ of Vibrate on the Alert mode
screen

The Alert Mode is set to Vibrate, and $$ is displayed on the Status bar.
e Tap $$ of Silent to mute the FOMA handset for incoming calls/messages as you tap $$
of Audio to ring the ring tones.



l Setting a Vibrate Pattern I

You can select from the different vibrate patterns provided.

'I Tap $$ » $$ on the Application Selector bar, and tap the General
tab ® Ringtune Manager tab on the Control panel screen, and then
on the Ringtune Manager screen, tap the Vibrate tab

2 Tap the vibrate pattern to use
¢ Tap the vibrate pattern and tap $$ to test the pattern. Tap $$ to stop vibration.

3 Tap [Done]

* The vibrate pattern is set.
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Keypad Tones

Setting Keypad Tones

| Default setting ‘ Normal ‘

You can select keypad sound in the Phone number entry screen.

Tap $$ on the Application Selector bar, and tap Settings » Tones
on the Menu bar

Normal: Normal keypad tone.
Beep : Beep tone.
Silent : Keypad tone is muted.

2 Tap $$ of the sound to set on the Keypad tones

3 Tap [Done]
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The keypad tone is set.
¢ Tap [Cancel] to cancel the keypad tone setting.

Audible Timer

Sounding the Audible Timer during a Call

‘ Default setting | Audible Timer: OFF ‘

You can set your FOMA handset to alert you with the Audible timer when the set time has
elapsed during a call. You can also use the repetitive alarm function.

Tap $$ on the Application Selector bar, and tap Settings » Call
tracking on the Menu bar

Audible Timer : Sets the time to play the Audible timer.
Repetitive : Plays the repetitive alarm for all recurring times
you set.

2 Tap Audible timer and select the time
¢ Tap [OFF] to mute the Audible timer.

3 Tap $$ of Repetitive

« If you do not tap $$, the alarm plays only once at a set time.

4 Tap [Done]

The Audible timer is set.

Manner Mode

Muting Sounds Made by Your FOMA Handset

You can set this function to avoid disturbing people around you by muting the sounds made by
your FOMA handset such as ring tones, keypad tones and tap tones.
¢ You can customize operations during Manner Mode. — P129

'I Press for 1+ seconds in idle state

The Manner Mode is set.
¢ $$ is displayed on the Status bar.

HlTo cancel Manner Mode
Press for 1+ seconds in idle state
The Manner Mode is canceled and $$ is displayed on the Status bar.



Original Manner Mode

Personalizing Manner Mode

‘ Default setting | All items: $$ ‘

You can customize operations while Manner Mode is set.

Tap $$ » $$ on the Application Selector bar, and tap the Handset
tab » Manner Mode tab on the Control panel screen

Mute Ring tone : Disables ring tones.

Mute Vibrator : Disables the vibrator.

Increase Microphone gain: Sensitizes the microphone so that
the other party can hear you easily
even when you talk in a small

voice.
Mute Keypad tones : Disables keypad tones.
Mute Low Battery alert  : Disables the low battery alert.

2 Tap $$ of the item to set
3 Tap [Done]

The operations during Manner Mode are set.
¢ Tap [Cancel] to cancel the settings.
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Home Screen

Personalizing Home Screen

You can customize the display of the Home screen to show new messages and application
shortcuts. To view the Home screen, tap $$ on the Application Selector bar.

Wallpaper
Calendar
Time
Message Area

Application Shortcuts

Home screen
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l Setting Message Area View I

‘ Default setting ‘ All items: $$

You can display information you want in your Message Area such as the number of new
messages and tasks you have in the To do list = P42

'I Tap Home ¥» Preferences on the Menu bar on the Home screen

WN
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NOTE

Email
Voice
SMS
Calendar
To do list

Tap $$ of the item to set
Tap [Done]

: Shows the number of unread Email messages.
: Shows the number of new voice messages.

: Shows the number of unread SMS messages.

: Shows the number of appointments of the day.

: Shows the number of active tasks in your To do

list.

* How to operate = P129

The Message Area in the Home screen shows the items you set.

¢ Tap [Cancel] to cancel the settings

* Tap an item on the Message Area on the Home screen to activate the corresponding application.

—

Setting Applications to Shortcut Key

| Default setting ‘ Application 1:Video Application 2:lmage Application 3:Music ‘

You can set your favorite applications to the shortcut keys on the Home screen.

128

Tap Home ¥ Preferences on the Menu bar on the Home screen, and
tap the Application tab on the Preferences screen

Application 1
Application 2

Application 3

: Creates a shortcut to an application on the left

icon.

: Creates a shortcut to an application on the

middle icon.

: Creates a shortcut to an application on the right

icon.

* How to operate — P129



2 Tap any of Applications 1, 2 or 3 and select the application to be
linked to the shortcut

3 Tap [Done]

The application is linked to the shortcut key and the corresponding icon is displayed.
* Tap [Cancel] to cancel the settings.

NOTE

* When you set an application you installed to the shortcut key, $$ appears as the shortcut key icon on the
Home screen.
* Tap the shortcut key on the Home screen to activate the application you linked.

\__________________________________________________________________________/4
l Setting the Wallpaper I

You can set an image you captured or downloaded to display in the background of the Home
screen.

'I Tap Home % Wallpaper on the Home screen on the Menu bar

* How to operate = P129

2 Tap [Change]

The name of the image folder is displayed.
Images available for the wallpaper are displayed.

¢ Tap [Default] to reset to the default image.

3 Tap the image you want to set as the wallpaper

The image is selected.
* Tap Folder to select a folder.
e Tap $$ of List to switch to list display. Tap $$ of Thumbnail to switch to thumbnail display.

4 Tap [Select]

The wallpaper is set.
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NOTE

* You can set the following images for the wallpaper:

File format . GIF, JPEG, BMP, WBMP, PNG
Image size 1 1280 x 1280 pixels
File size : Upto4.6 MB

* |f size varies between the selected image and the wallpaper, the image is automatically adjusted to the
wallpaper size.

* The CD-ROM accompanying your FOMA handset contains images for the wallpaper. To set the images to
the wallpaper, install them to the FOMA handset.

Setting the Calendar

l Default setting | Turn calendar off

You can display the Calendar on the Home screen.

'I Tap Home W Turn calendar on on the Home screen on the Menu bar

The Calendar is displayed on the Home screen.
* How to operate — P129
¢ To hide the Calendar, tap Home — Turn calendar off on the Menu bar.

NOTE

* You can see your Calendar entries in several views. = P334
* Tap Calendar on the Home screen to open the calendar screen and add a Calendar entry.
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Showing the Time and Date

| Default setting | Hide time ‘

You can display the time on the Home screen.

'I Tap Home » Turn time on on the Home screen on the Menu bar

The time appears on the Home screen.
* How to operate = P129
* To hide the time, tap Home » Turn time off on the Menu bar.

NOTE

* You can see your clock in several views. = P142
* Tap Time on the Home screen to open the Date and time screen. You can set various clock settings including
the Date and time, clock views and alarm.
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Adjusting the Screen Brightness

You can adjust the backlight brightness for the display.

Tap $$ » $$ on the Application Selector bar, and tap the Handset
tab on the Control panel screen » Screen

2 Drag the slider to the desired brightness
3 Tap [Done]

The screen brightness is adjusted.
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Adjusting the Touch Screen Calibration

You can set the calibration between the tapping position of the stylus and the area recognized by
the touch screen.
¢ When you turn on your FOMA handset for the first time, the calibration screen is displayed. — P58
Tap $$ » $$ on the Application Selector bar, and tap Handset
Screen ¥ Calibrate on the Control panel screen

2 Tap the center of the circles from 1 to 3 in sequence

« Press €% to stop calibration.
« Press @ to reset to the default settings.
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3 Tap [Done]

The screen calibration is set.

NOTE

* When calibrating, avoid tapping a point far from the center of the circle. Applications may not operate
accurately. Adjust the screen calibration again.
* Pressing <<= for 10 seconds also opens the calibration screen.

Call tracking

Displaying Call Duration

‘ Default setting ‘ Show: time ‘

You can display the duration of a call on the talking screen.

Tap $$ on the Application Selector bar, and tap Settings % Call
tracking on the Menu bar

Show : Shows/hides the duration on the talking screen.

2 Tap Show, and then tap OFF/Time

The Call tracking is set.

Setting the Power Saving Options

| Default setting | Power down screen: After 1 minute Switch off light: After 30 seconds Display on: ON Status LED: $$

You can set the options of Power saving mode such as the time to turn off the backlight or screen
display. You can also configure to cancel Power saving mode by tapping the touch screen.



'I Tap $$ » $$ on the Application Selector bar, and tap Handset tab
®» Power on the Control panel screen

Power down screen
: Selects the time to turn off the display.
Switch off light: Selects the time to turn off the backlight.
Display on : Configure to enable tap operation to cancel
Power saving mode.
Status LED  : Sets the Status LED to turn ON/OFF.

Tap Power down screen to select the time to turn off
Tap Switch off light to select the time to turn off
Tap $$ of Display on

¢ If you tap $$, tapping the touch screen does not cancel Power saving mode. However,
pressing a key cancels the mode.

Tap $$ of Status LED
¢ Tap $$ to turn the Status LED on, tap $$ to turn it off.

6 Tap [Done]

The Power saving mode options are set.

NOTE

¢ About Power saving mode P42
¢ The time for Switch off light must occur before Power down screen. Set the same time as Power down screen or
shorter time.

U1 2N
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Switching the Application Launcher View

You can change the views and background of the Application Launcher.

l Changing an Application Launcher View Style I

‘ Default setting | View as icons ‘

You can see applications to be displayed on the Application Launcher as icons or as a list.
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Tap $$ on the Application Selector bar, and tap View on the Menu
bar

Tap $$ of View as icons/Show as list

View as icons Show as list

¢ The view of the Application Launcher is set.

l Setting the Background for Application Launcher l

You can set an image you captured or downloaded to display as the background of the
Application Launcher.

]
2

Tap $$ on the Application Selector bar, and tap View » Appearance
on the Menu bar

On the display setting screen, tap Background and then tap Find
image

The name of the image folder is displayed.

Images available for the background are displayed.

¢ Tap [None] to display no background.
* |f you have previously set an image as the background, this
image is also displayed.




3 Tap the image you want to set as the background

* Tap Folder to select a folder.
e Tap $$ of List to display as a list, tap $$ of Thumbnail to display thumbnails.

4 Tap [Select]

The selected image is displayed.

Slider

5 Adjust the image display

The following operations can be performed.

¢ Drag the slider up/down to enlarge/reduce the image.

* |f the image is larger than the screen, drag the image up/down or left/right to adjust its
position.

* Tap $$ of Tile to tile and display images smaller than the screen.

6 Tap [Done]

The background is set.

NOTE

¢ You can set the following images for the background:
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File format : GIF, JPEG, BMP, WBMP, PNG
Image size 1 1280 x 1280 pixels
File size : Upto 4.6 MB

Changing the Phone Number Entry Screen Settings

‘ Default setting | Skin: Default ‘

You can change the design (skin) of the Phone number entry screen.
¢ Your FOMA handset contains Default only. To change the skin, you have to obtain your desired skin by
downloading it from the Internet.
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Tap $$ on the Application Selector bar, and tap Settings » Show on
the Menu bar

2 Tap Skin to select the skin
3 Tap [Done]

The design of Phone number entry screen is changed.

Setting Display for Numerical Values
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You can set how your FOMA handset shows numerical information such as distance, currency
and decimal points.
¢ The FOMA handset shows numerical information in the format set here only with compatible applications.
Your FOMA handset contains no compatible applications at time of purchase.
'I Tap $$ » $$ on the Application Selector bar, and tap the General
tab ® International tab on the Control panel screen, and then tap

the Numbers tab on the International screen

Long distance : Selects the unit for long distance between the
yard-pound and metric systems.
Short distance: Selects the unit for short distance between the
yard-pound and metric systems.
Decimal separator
: Selects how to show decimals.
Thousands separator
: Selects how to separate thousands.
Currency : Enters the name/symbol of the currency.
Symbol position
. Positions the currency (name/symbol) set in
Currency.

2 Tap Set and select the display format

The unit and display format are set.
¢ When you tap Currency, enter the name/symbol of the currency.
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Zooming in/out the Display

| Default setting | Zoom: Middle

You can enlarge/reduce the display size of characters and icons on the screen for the following
applications:
* You can change the display size for the following application:
- Browser (Only for bookmarks and while displaying stored pages)
- Email
- Music (Not available while displaying details)
- Video (Only while displaying list)
- Contacts
- Calendar (Only for Day view)
- Notes
- To do list (Only while displaying list)
- SyncML

<Example: Changing the display size of the Contact list screen>

Tap $$ on the Application Selector bar, and tap Edit » Zoom on
the Menu bar

Small : Zooms out.
Middle : Normal display.
Large : Zooms in.
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¢ To zoom in/out from the other applications, tap Edit » Zoom on
the Menu bar.

2 Tap $$ of the desired size, and then tap [Done]
Display size is set.

NOTE

* Turning the power off does not reset the configured display size setting you set.
* The size of characters is changed only when the Language Selection is set to English.
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Clock Settings

Setting the Time and Date

You can change the display format of date and time for the Home screen.

'I Tap $$ » $$ on the Application Selector bar, and tap the General
tab ® Date and Time on the Control panel screen, and then tap the
Format tab on the Date and Time screen

Date format : Sets the date format.
Date separator: Selects how to delimit months and days.
Time format : Selects from the 12-hour and 24-hour format.
Time separator
. Selects how to delimit hours, minutes and
seconds.

Tap the field to set and select the display format

The display format is set.
¢ When you tap Time format, tap $$ of the desired display format.



Safety Settings

M Security Codes o

Security Codes Used for FOMA handset ..................... ..., 140
Changing Handset Security Code <Handset Security Code>............ 141
Setting PIN. . ... i i e e 143
Unblocking PIN . ... .ot it et e i et atnaennenas 145
About Lock Functions ...........c.ciiiiiiiii ittt e tneinanans 147
Preventing Unauthorized Use <AllLock>. ..........ccoiviiniinnnnnns 147
Preventing Incoming/Outgoing Calls and Messages <Self Mode> ....... 149
Rejecting Calls from Specified Numbers <RejectCall>................. 149
Making Calls to Specified Numbers Only <Fixed Dialling>.............. 151
Rejecting Calls with No Caller ID <Call Settingw/oID> ................ 152
Muting Ring Tone for Calls from Callers Not Stored in Contacts

<Ringless Time Setting>. ... .. ... i e e e 153
Rejecting Calls from Callers Not Stored in Contacts

<RejectUnknown> .. ... ...ttt ittt a e 153
B About Other "Safety Settings"

About Other Safety Settings .............ciiiiiiiiiiiii it 154

139



sbumes Ajejes '

140

Security Codes Used for FOMA handset

Some FOMA handset functions require security codes. Use appropriate functions or service

passwords for safe use of your FOMA handset.

* If you forget these security codes, you are required to bring your FOMA handset and ID (your driver's license,
etc.) to a DoCoMo shop.

¢ Change the security codes to prevent tampering. Also, keep a separate record of your security codes.

Handset Security Code

There are 2 security codes for the FOMA handset.

B Handset Security Code
The 1- to 16-digit password set to the FOMA handset to be entered when using the following
functions:
- Unlocking All lock
- Reject Call
- Call Setting w/o ID
- Reject Unknown
You can change Handset Security Code as you desire. = P147

M Authentication Password
The 1- to 16-digit password to be entered when using Master Reset/Master Clear.
You can change Authentication Pasword as you desire. = P148

Network Security Code

The 4-digit password to be entered when using the Network services or DoCoMo e-sites. You
can specify it at the time of purchase. Be careful never to reveal your Network Security Code to
others.

If you forget your Network Security Code, please contact "General contact" on the back of this
manual. At a DoCoMo shop, your ID such as your driver's license is required for password
renewal. If you already have "User ID" or "Password", you can renew your password at the
DoCoMo e-site via a PC.

* For details on the "DoCoMo e-sites," see the back of this manual.

PIN1/PIN2

The 4- to 8-digit password set to the UIM to be entered when using the following functions:
PIN1 : Enter the PIN1 every time when you turn your FOMA handset on for user
authentication. If entered incorrectly, you cannot make or answer calls or
operate communication functions. Your FOMA handset is set to enable
operations without entering the PIN1 by default. = P149
PIN2 : Enter the PIN2 when restricting incoming or outgoing calls such as Fixed
Dialling. = P158

You can change the PIN (PIN1/PIN2) as you desire. = P150




Handset Security Code

Changing Handset Security Code

You can change the 2 types of passwords of your FOMA handset: "Handset Security Code" and
"Authentication Password".

l Changing Handset Security Code I

No Handset Security Code is set to your FOMA handset by default.

Tap $$ » $$ on the Application Selector bar, and tap the Handset
tab ®» Password on the Control panel screen, and then tap the
Security tab » Set Security Code on the Password screen

sbumes fiojes .

2 Enter a new Handset Security Code » tap [Done]

* The screen with the new Handset Security Code entered appears.

3 Enter again the new Handset Security Code » tap [Done]
¢ The Handset Security Code is changed.

NOTE

* You can also set the Handset Security Code during function settings such as Reject Call.
"
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l Changing Authentication Password I

=2 W

‘ Default setting | 000000

Tap $$ » $$ on the Application Selector bar, and tap the Handset
tab ®» Password on the Control panel screen, and then tap the
Security tab W Set Authentication Password on the Password screen

Enter your current Authentication Password $ tap [Done]

* The New password entry screen appears.

Enter a new Authentication Password » tap [Done]

* The screen with the new Authentication Password entered appears.

Enter again the new Authentication Password » tap [Done]

¢ The Authentication Password is changed.



l Enabling PIN l

\ Default setting | PIN1: §$ (OFF)  PIN2: $$ (OFF) \

You can enable PIN1/PIN2.

Tap $$ on the Application Selector bar, and tap Settings » Security
on the Menu bar

2 On the Security screen, tap $$ of PINI/PIN2

PIN1 entry screen

3 Enter the PIN ¥ tap [Done]

* The PIN is set.
¢ Entering an incorrect PIN 3 times in succession, the PIN will be blocked. = P151

l Entering PIN1 I

When the PIN1 is enabled, the PIN1 entry for user authentication is required every time you turn
your FOMA handset on.
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'I Turn on your FOMA handset

* How to operate — P124

2 Enter the PIN1 » tap [Done]

The Home screen appears.
* Entering an incorrect PIN1 3 times in succession, the PIN1 will be blocked. = P151

NOTE

* When the PIN2 is enabled, the PIN2 entry for user authentication is required when restricting calls such as
Fixed Dialling. = P158
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l Changing PIN I

‘ Default setting ‘ PIN1: 0000  PIN2: 0000 ‘

You can change PIN1/PIN2.
* To change the PIN1, you have to enable the PIN1. — P149

Tap $$ on the Application Selector bar, and tap Settings » Security
on the Menu bar

2 On the Security screen, tap [Change] on PIN1/PIN2

sbumes fiojes .

PIN1 entry screen

3 Enter the current PIN » tap [Done]

* The New PIN1 entry screen appears.
* Entering an incorrect PIN 3 times in succession, the PIN will be locked. — See below

4 Enter a new PIN » tap [Done]

* The screen with the new PIN entered appears.

5 Enter again the new PIN $ tap [Done]
* The PIN is changed.

Unblocking PIN

If you enter an incorrect PIN (PIN1/PIN2) 3 times in succession, the PIN is locked. In this case,
enter the PUK (PUK1/PUK2) to unblock the PIN. The PUK is the 8-digit number specified at the
time of purchase and cannot be changed.

* After unblocking PIN, enter a new PIN to use your FOMA handset.

145



N

'I With PIN locked, tap $$ on the Application Selector bar, and
enter * * 05 * [+ * 052 * % [Done] on the Phone number entry
screen

¢ To unblock PIN1, enter * * 05 * .
¢ To unblock PIN2, enter * * 052 *,

Enter the PUK » tap [Done]

* The New PIN1 entry screen appears.

Enter a new PIN code » tap [Done]

¢ The screen with the new PIN entered appears.
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Enter again the new PIN $» tap [Done]
* The PIN is unblocked.

o=

rIPIN Lock and PUK
If you enter an incorrect PIN (PIN1/PIN2) 3 times in succession, the PIN is locked. In this
case, the PUK (PUK1/PUK2) entry is required for unblocking PIN. If you enter an incorrect
PUK 10 times in succession, the UIM is locked and your FOMA handset is disabled. Note that
you keep a separate record of these codes just in case you forget them. If you forget the
codes, contact one of DoCoMo shops.

Authentication
OK FOMA handset
’ is enabled
Authentication
Enter PIN Wrong entry OK Set new PIN code to enable
3 times in ' FOMA handset
succession Enter PUK Wrong entry
;3;2:';: UIM is locked (Contact one
of DoCoMo shops)
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About Lock Functions

The FOMA handset provides lock functions to prevent unauthorized use by third person or
disable communication functions. Use an appropriate lock function from the following:

Lock function Description Reference
All Lock Disables FOMA handset operations to prevent
unauthorized use by third person. When this function is set,
the Handset Security Code is required to use your FOMA P153
handset when you turn the handset on or cancel Power
saving mode.
Self Mode Disables all communication and transmission functions.
Use this function when playing a game with no P155
communication function in locations where talking and
exchanging messages are prohibited/restricted.

NOTE

* Note that you keep a separate record of your Handset Security Code just in case you forget them.
e

sbumes fiojes .

All Lock
Preventing Unauthorized Use

‘ Default setting ‘ Handset Security Code: Not set

Use this function to lock all operations of your FOMA handset.
¢ When All Lock is set, you can make/answer no call.

'I Set the Handset Security Code

* How to operate = P147

Slide [ ] upward until it locks
All Lock is set.
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l Unlocking All Lock I

'I Slide @ downward to its original position

Tap [Unlock], and enter the code » tap [Done] on the Handset
Security Code entry screen

All Lock is unlocked.

¢ Tap [Owner] to show the owner information.

* Tap [Emergency Call] to open the emergency call entry screen to make an emergency
call.

l Saving Owner Information I
[oetautt seting [ None |

Default setting | None

sbumes Ajejes '
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You can store your owner information to be displayed on the All lock cancel screen.
* You can view the owner information on the All lock cancel screen. = P153

Tap $$ » $$ on the Application Selector bar, and tap the Handset
tab ®» Password on the Control panel screen

2 Enter the owner » tap [Done]

Your owner information is stored.
* Up to 128 double- or single-byte characters can be entered.
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Self Mode
Preventing Incoming/Outgoing Calls and Messages

‘ Default setting ‘ Signal strength: Handset ON ‘

You can disable all communication and transmission functions such as making/answering calls,
exchanging messages, packet/data/Bluetooth communications by stopping transmitting radio
signals.

Useful when using an application with no communication function in locations where talking and
exchanging messages are prohibited/restricted.

'I Tap $$ on the Status bar

sbumes fiojes .

2 Tap Self Mode % [OK]

Self Mode is set and $$ appears on the Status bar.
¢ Tap Handset ON % [OK] to cancel Self Mode.

NOTE

* When Self Mode is ON, callers will hear a message that you are in an area with no radio wave or the power
is turned off. If you are contracting the Voice Mail Service or Call Forwarding Service, these services are
available.

¢ You can dial emergency call numbers (110, 119 and 118) even during Self Mode. In this case, Self Mode is
automatically canceled.

Reject Call
Rejecting Calls from Specified Numbers

‘ Default setting | Call Reject List: $$ (OFF) Edit Call reject Number: None ‘

You can reject calls from callers you do not want to talk by storing their numbers.

* In addition to this function, setting the "Caller ID Display Request Service" and the "Call Setting w/o ID" is
recommended.

¢ The callers will hear the busy tone. Your FOMA handset performs no arrival call acts and the calls are
recorded in Missed call history.
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Tap $$ on the Application Selector bar and tap Settings % Call
control on the Menu bar, and then tap the Reject tab on the Call
control screen

Tap $$ of Call Reject List, and enter the code » tap [Done] on the
Handset Security Code entry screen

* If you have not set a Handset Security Code, the New Handset Security Code entry
screen appears. Set the code. — P147

Tap [Edit Call reject Number], and enter the code » tap [Done] on
the Handset Security Code entry screen

Call reject list screen

Tap the number » [Edit], and enter the number to reject » tap
[Done] on the Call reject list screen

* Up to 20 numbers can be stored in the Call reject list.
* To store another number, repeat Step 4.

Tap [Done]

Reject Call is set.

NOTE

¢ Calls with no Caller ID are not rejected.

* Even when the "Voice Mail Service" or "Call Forwarding Service" is set to ON, these services are enabled if
you set the ringing time to 0 second.

* |f the caller has sent no Caller ID, your FOMA handset acts according to the "Call Setting w/o ID" settings.

* You can receive SMS/email messages regardless of this setting.



* You can make calls to the number stored in the Call reject list.

"
l Deleting the Registered Callers I

You can delete the numbers stored in the Call reject list.

'I Tap the number to delete on the Call reject list screen

* How to operate — See above

2 Tap [Clear] » [Done]

The selected number is deleted.

Fixed Dialling

Making Calls to Specified Numbers Only

‘ Default setting \ Fixed Dialling: $$ (OFF) Call Permitted List: None ‘

You can allow your FOMA handset to make calls only to specified numbers.

sbumes fiojes .

Tap $$ on the Application Selector bar, and Tap Settings ¥ Security
on the Menu bar, and then tap the Fixed Dialling tab on the
Security screen

2 Tap $$ of Fixed Dialling, and enter the code ¥ tap [Done] on the
PIN2 entry screen
+ PIN2 — P147

3 Select the number » tap [Edit], and on the PIN2 entry screen,
enter the code » tap [Done], and then enter the number ¥ tap
[Done] on the Fixed dialling entry screen

The Fixed dialling is set.
* Up to XX numbers can be stored in the Fixed dialling list.
» To store another number, repeat Step 3.
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NOTE

* You can receive calls from numbers not stored in the Fixed dialling list.

Call Setting w/o ID

Rejecting Calls with No Caller ID

| Default setting | From Public Phones: $$ (OFF) Private ID: $$ (OFF) With Unknown ID: §$ (OFF)

You can reject calls with no Caller ID depending on the reason for no ID.
¢ There are 3 reasons for no Caller ID as follows:

Reason for no ID Reason
User unsent When the caller selected not to send the Caller ID
Public Phone Calls from public phones
Not supported Calls from parties who cannot send the Caller ID such as from overseas
or from land lines via call forwarding services. (However, some phone
companies may send the Caller ID.)

¢ The callers will hear the busy tone. Your FOMA handset performs no arrival call acts and the calls are
recorded in Missed call history.
Tap $$ on the Application Selector bar, and tap Settings % Call
control on the Menu bar, and then tap the Reject tab on the Call
control screen

From Public Phones
: Rejects calls with Reason for no ID is set to
"Public Phone"
Private ID : Rejects calls with Reason for no ID is set to
"User unsent"
With Unknown ID
: Rejects calls with Reason for no ID is set to
"Not supported”

2 Tap $$ of one of the Reasons for no ID, and enter the code » tap
[Done] on the Handset Security Code entry screen

The Call Setting w/o ID is set.

¢ |f you have not set a Handset Security Code, the New Handset Security Code entry
screen appears. Set the code. — P147

* You can reject calls with any of these reasons for no Caller ID.

NOTE

* Even when the "Voice Mail Service" or "Call Forwarding Service" is set to ON, these services are enabled if
you set the ringing time to 0 second.
* You can receive SMS/email messages regardless of this setting.



Ringless Time Setting
Muting Ring Tone for Calls from Callers Not Stored in Contacts

‘ Default setting | 0 second ‘

For calls from callers not stored in Contacts, you can set the start time of ringer actions (such as

the ring alert, vibrator, and incoming Status LED actions) not to start immediately.

* Calls disconnected before the ringer actions start are recorded as missed calls with no ring alert , and by
default will not be shown in Missed call history. You can set to display them in Missed call history. = P82

Tap $$ on the Application Selector bar, and tap Settings » Tones
on the Menu bar

sbumes fiojes .

2 Tap Ring start time (Seconds), and enter the start time $» tap [Done]
on the Ringing time entry screen

The ringless time is set.
¢ Enter 0 to 99 seconds for the start time.

NOTE

¢ |f the caller stored in Contacts sends no Caller ID and ends the call before the ringer actions start, your
FOMA handset acts no ringer actions. However, when the "Call Setting w/o ID" or "Reject Unknown" is set
to ON, your FOMA handset acts according to these settings.

* When the "Voice Mail Service" or "Call Forwarding Service" is set to ON, these services are activated at their
start time regardless of this setting.

Reject Unknown

Rejecting Calls from Callers Not Stored in Contacts

You can reject calls from anyone whose phone number is not stored in Contacts.

¢ In addition to this function, setting the "Caller ID Display Request Service" and the "Call Setting w/o ID" is
recommended.

¢ The callers will hear the busy tone. Your FOMA handset performs no arrival call acts and the calls are
recorded in Missed call history.
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Tap $$ on the Application Selector bar, and tap Settings % Call
control on the Menu bar, and then tap the Reject tab on the Call

control screen

Reject Unknown is set.

sbumes Ajejes '
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Tap $$ of Not In Contacts, and enter the code » tap [Done] on the
Handset Security Code entry screen

* |f you have not set a Handset Security Code, the New Handset Security Code entry
screen appears. Set the code. = P147

NOTE

* Calls with no Caller ID are not rejected. However, when the "Call Setting w/o ID" or "Ringless Time Setting"
is set to ON, your FOMA handset acts according to these settings.
* Even when the "Voice Mail Service" or "Call Forwarding Service" is set to ON, these services are enabled if

you set the ringing time to 0 second.

* If the caller has sent no Caller ID, your FOMA handset acts according to the "Call Setting w/o ID" settings.
* You can receive SMS/email messages regardless of this setting.

About Other Safety Settings

In addition, you can use the following safety settings:

(virus)

Purpose Function/Service name Reference
To block "nuisance calls" such as mischievous calls or | Nuisance Call Blocking Service P371
frequent malicious calls
To protect your FOMA handset from vicious files Virus scan function P540
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Before Using Camera

Using Still Pictures and Video Clips Shot

You can display or play back still pictures and video clips you shot with the camera as well as
using them for the following various usages:

¢ Viewing pictures continuously as a slide show — P276

¢ Editing images — P277

¢ Attaching images to email = P310

* Storing images in TransFlash memory card — P177

¢ Sending images via Bluetooth = P310

* Storing images in PC with Desktop Suite = P527

Notes When Using Camera

* Clean images cannot be obtained if the lens is stained with fingerprints or grease. Wipe the lens with a soft
clean cloth before shooting an image.

* |If the FOMA handset is left in a warm place for a long period prior to shooting/saving images, image quality
may be deteriorated.

* Hold your FOMA handset firmly or place it on a stable place and use the self-timer when shooting. Otherwise,
the image may be blurred.

* Note that if you attempt to take a picture of a strong light source such as the sun or a lamp, the image may
become dark or may be degraded.

* Although the camera is manufactured using extremely precise technology, it may contain black and bright
pixels and lines appearing constantly on the display. Also, shooting in poor lighting conditions may cause
noises such as white lines to appear in a picture.

* Images shot by the camera may differ from actual subjects in color and brightness.

Copyrights and Portrait Rights

You are not allowed, by the Copyright Act, to reproduce, modify or edit the information recorded
by FOMA handset without consent of the copyright holders except for personal use. Also, please
refrain from unauthorized use of portraits or names of other persons without permission that may
infringe on the portrait rights. Please be aware of copyrights and portrait rights when posing
recorded data on Web pages. Note that filming or recording plays, entertainment, and exhibitions
may be prohibited even if for personal use.

? Please be considerate of the privacy of individuals around you when taking and

sending photos using camera-equipped mobile phones.
[ ]




Using the Camera

You can use the cameras to take still pictures or record video clips as follows:

M Shooting in landscape view
Back-Camera is suitable for taking persons or landscapes.

lllustration

B Shooting in portrait view
Front-Camera is suitable for taking yourself.

lllustration

The cameras are located at the front (Front-camera) and back (Rear-camera). You can switch
between these cameras during shooting.

Front-camera Rear-camera

Your image appears
horizontally reversed
(mirror image) on the
display. Still pictures and
video clips shoot and saved
appear as normal images.

elowen .
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Shot Screen and Saving Format

Still mode screen

Video mode screen

Icon name Icon Description
(@ Shot mode $$ Appears when Still mode is set.
$$ Appears when Video mode is set.
(2 Still picture shot size $$ Rear- Shot size: XL (1280 x 960)
$$ camera | gnot size: L (640 x 480)
$$ Shot size: M (320 x 240)
$$ Shot size: S (160 x 120)
$$ Front- Shot size: L (640 x 480)
$$ camera | ghot size: M (320 x 240)
$$ Shot size: S (160 x 120)
(® Self-timer ON $$ Appears when Self-timer is activated.
(@ Audio OFF $$ Appears when recording video with audio set to OFF.
(B Creating new picture $$ Appears when camera is starting up.
® REC $$ Appears when recording video.
@S.avable number of 35 Displays the maximum number of still pictures you can take.
pictures
R.ecorda.ble number of 35 Displays the maximum number of video clips you can record.
video clips
(® Shutter $$ Tap $$ to shoot an image.
REC/STOP $$/$$ Tap $$/$$ to start/stop recording.
(@) .Retfording progress 35 Displays the estimated remaining time.
indicator
12 Image viewer* $$ Tap $$ to view stored images.
@3 Video player $$ Tap $$ to play video.
Switch camera $$ Tap $$ to switch between Front-camera and Rear-camera.
@ Still mode* $$ Tap $$ to switch to Still mode.
Video mode* $$ Tap $$ to switch to Video mode.

*

Does not appear if you open the still mode screen from Contacts (— P103).




Still Picture Files

File format JPEG

Picture size XL (1280 x 960), L (640 x 480), M (320 X 240), S (160 x 120)
Extension .ipg

File name "PICXXXXXX" (X is a 6-digit number.)

* The picture file you took first is named "PIC000001". Then the picture file name
increases by one in the order of "PIC000002" — "PIC000003". The file that
comes after "P1C999999" is named "PIC000001".

If the file having the same file name is already saved in the FOMA handset/
TransFlash memory card, the new file name is automatically changed to the
next larger number.

Estimated Savable Number of Still Pictures

The savable number of still pictures varies depending on the setting values of Picture size/Picture

quality and shooting conditions.

Estimated capacity of FOMA handset (Number of pictures)

Picture size Picture quality
Best High Normal
XL (1280 x 960) 34 43 51
L (640 x 480) 148 183 226
M (320 x 240) 805 1022 1111
S (160 x 120) 3220 4130 5278

Estimated capacity of TransFlash memory card (Number of pictures)

Picture size Picture quality
Best High Normal
XL (1280 x 960) 57 72 85
L (640 x 480) 249 308 380
M (320 x 240) 1356 1720 1871
S (160 x 120) 5424 6957 8889

* The table above shows the estimation when using the attached TransFlash memory card (sample).

Video Clip Files

File format

MP4 (MobileMP4)

Coding system

Video: MPEG4 Voice: AMR

Video size

QCIF (176 x 144)

Extension

.3gp

elowen .

159



elowe) '

160

File name

"MOVXXXXXX" (X is a 6-digit number.)

¢ The video file you recorded first is named "MOV000001". Then the video file
name increases by one in the order of "MOV000002" — "MOV000003". The file
that comes after "MOV999999" is named "MOV000001".
If the file having the same file name is already saved in the FOMA handset/
TransFlash memory card, the new file name is automatically changed to the
next larger number.

Estimated Recordable Number of Videos

The recordable number of videos varies depending on the setting values of Audio ON/OFF and

shooting conditions.

Estimated capacity of FOMA handset (Number of videos)

Recordable time (seconds) Audio
ON OFF
300 6 7
12 163 204

¢ The number of videos when recording up to the maximum recordable time.

Estimated capacity of TransFlash memory card (Number of videos)

Recordable time (seconds) Audio
ON OFF
300 10 13
12 275 344

¢ The number of videos when recording up to the maximum recordable time.
* The table above shows the estimation when using the attached TransFlash memory card (sample).

Taking Still Pictures

You can take still pictures with the camera. Still pictures you took are saved in "$$ Picture" (—
P274) or the TransFlash memory card (— P301). You can select the storage location (— P177).

'I Press

The camera starts up and the still mode screen appears.

* The image of camera previously used appears.

How to switch cameras. — P172

« If the video mode screen appears, tap $$ to switch the screen.



2

Point the camera at the object » press ltap $$

The shutter sounds and the FOMA handset takes the still

picture.

$$:Tap $$ to display the Send as screen to send the still picture
you took. = P310

$$:Tap $$ to display the Delete file screen to delete the still
picture you took.

Press (|/Tap $$

The still picture you took is saved.
e Tap $$ to view the still pictures you saved. = P274

r N
HEMenu bar
Tap Camera on the Menu bar to display the following items:
Camera settings . . ... ..ot e P176
Self-timer ON/OFF . . . . P174
Mirroring ON/OFF . . . . .o e P175
Low light ON/OFF . . . ..o e e P174
* Some items cannot be performed depending on operations.
[« v

NOTE

¢ The shutter sound cannot be muted or changed.

* Moving into Power saving mode (— P136) during shooting stand-by automatically ends the camera.

* $$ indicates that there is not enough space in the FOMA handset. Delete or move unnecessary files. —
P307, P308

Recording Video Clips

You can record video clips with the camera. Video clips you record are saved in "$$ Video" (—
P280) or the TransFlash memory card (— P301). You can select the storage location (— P177).

Press

The camera starts up and the still mode screen appears.
* The image of camera previously used appears.

How to switch cameras. = P172

 |f the video mode screen appears, go to Step 3.

elowen .
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2 Tap $$

The video mode screen appears.

M To record video with audio set to OFF

Tap Camera % Audio OFF on the Menu bar
 To turn Audio ON, Tap Camera % Audio ON on the Menu bar.
A d

3 Press (rrap $$

elowe) '

The shutter sounds and the FOMA handset starts recording.
* During recording, the camera light flashes in red.

/] Press (rrap $$

The shutter sounds and the FOMA handset ends recording.

$$ : Tap $$ to open the Send as screen to send the video
you recorded. — P310
$$ : Tap $$ to open the Delete file screen to delete the video

you recorded.
$$/$$ : Tap $$/$$ to start/stop playing back the video you
recorded.

5 Press (rrap $$

The video you recorded is saved.
¢ Tap $$ to view the video you saved. — P280
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EMenu bar
Tap Camera on the Menu bar to display the following items:
Camera SetlNGS . . . . oot P176
Self-timer ON/OFF . . ... P174
Low light ON/OFF . . . . o e e e P174
Mirroring ON/OFF . . . . o P175
Audio ON/OFF . . P170
[ |

NOTE

* The shutter sound cannot be muted or changed.

¢ Moving into Power saving mode (— P136) during shooting stand-by automatically ends the camera.

* When a call arrives during video recording, the video being recorded is automatically saved. However, if you
change into another application during recording, the video being recorded will not be saved.

¢ $$ indicates that there is not enough space in the FOMA handset. Delete or move unnecessary files. —
P307, P308

elowen .

Changing Shot Settings

You can change the camera settings for shooting with the camera activated.

Switching Cameras

You can switch between the Front-camera and Rear-camera.

'I Tap $$ on the still/video mode screen

Zooming

You can zoom in an object in the distance when shooting.
The table below lists the available magnifications depend on the image shot size.

Zoom magnification
Shot mode Image size

1x 2x 3x

Still pictures XL (1280 x 960) X X X
L (640 x 480) O O X

M (320 x 240) O O O

S (160 x 120) O O O

Videos - O O O

* You cannot use the zoom function when using the Front-camera.
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| Press (|| on the still/video mode screen

¢ Tapping $$/$$ also changes the zoom magnification.

NOTE
¢ Ending the camera cancels the zooming you adjusted.

Adjusting the Brightness

Default setting

You can adjust the brightness of the display to any of 5 levels (-2/-1/0/1/2).

A

A . .
'I Press ) on the still/'video mode screen » press <>
¢ Tapping $$/$$ also changes the brightness level.

NOTE
* Ending the camera cancels the brightness you adjusted.

Setting the Contrast

Default setting

You can set the contrast of the display to any of 5 levels (2/-1/0/1/2).

VN

'I Press @) on the still/video mode screen ¥ press €»

¢ Tapping $$/$$ also changes the contrast level.



NOTE
¢ Ending the camera cancels the contrast you adjusted.

Using Self Timer

If you set Self timer to ON, images are automatically shot about 10 seconds later.

Tap Camera ¥ Self timer ON on the Menu bar on the still/video
mode screen

elowen .

2 Press [/tap $$/$$

The counter sounds and the image is shot about 10 seconds later.
¢ To stop Self timer, press @/tap $$.

NOTE
¢ When the shot by Self timer ends, Self timer setting is automatically canceled.

Using Low Light Mode

‘ Default setting | Low light OFF

Use this function when shooting in poor light conditions.

Tap Camera % Low light ON on the Menu bar on the still/video
mode screen
e Tap Camera % Low light OFF on the Menu bar to turn Low light OFF.

Turning Mirroring ON/OFF

‘ Default setting | Mirroring ON

You can display an image horizontally reversed (Mirroring ON) or display as a normal image
(Mirroring OFF).
¢ You can turn Mirroring On/OFF only when using the Front-camera.

165




'| Tap Camera % Mirroring OFF on the Menu bar on the still/video
mode screen

¢ Tap Camera % Mirroring ON on the Menu bar to turn Mirroring ON.
e Still pictures/video clips you shot are saved as normal images (Mirroring OFF) regardless
of this setting.

Changing the Camera Settings

Default setting | Image size: Middle Image quality: Best Maximum duration: 300 seconds Ambient
lighting: Auto Flicker correction: 50Hz

You can change the camera settings such as the size and quality of still pictures/video clips to be
shot with the camera.

Tap Camera % Camera settings on the Menu bar on the still/video
mode screen, and tap the item to set, and tap [Done] after setting

elowe) '

Camera settings screen Camera settings screen
for still pictures for video clips
Image size
Extralarge : SXGA (1280 x 960 dots)
Large : VGA (640 x 480 dots)
Middle : QVGA (320 x 240 dots)
Small : QQVGA (160 x 120 dots)
Image quality
Best : Best quality. The maximum number of shots you can take decreases.
High : High quality.
Normal : Standard quality. The maximum number of shots you can take increases.

Maximum duration
300 seconds : Shooting is available up to about 300 seconds.
12 seconds : Shooting is available up to about 12 seconds. The file size of images you
shot is about 100 Kbytes.
Ambient lighting
Auto : Adjusts white balance automatically.
Sunny : When shooting outdoors in fine weather.
Indoor Home : When shooting under bulb/incandescent lighting.
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Indoor Office : When shooting under fluorescent lighting.

Flicker correction
50Hz : If flicker occurs when shooting under fluorescent lighting at 50 Hz.

60Hz : If flicker occurs when shooting under fluorescent lighting at 60 Hz.

l Setting Saving Destination I

You can select the storage destination for still pictures/video clips you shot.

Tap Unfiled* ¥ the destination folder name on the Menu bar on
the still/video mode screen

*: The name of folder previously selected appears.

elowen .
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About the Internet

You can browse Web pages via the Internet.

@®Opening Web Paves — P192

You can access to the Internet easily to
browse Web pages created for PCs.

@Adding Bookmarks — P204

You can open Web pages you
frequently view quickly by adding

bookmarks for the pages.

N |
@Downloading Data from Web Pages

@ Saving Web Page Information

— P207

You can save Web pages you might

want to refer to later.

Using the Internet

— P211

You can download various applications

from the Internet and save them in your
FOMA handset.

To use the Internet, you need to use mopera (— P182), subscribe to an Internet service provider
that supports FOMA, and make the Internet connection setting (— P185). For details, see
"Preparation Flow for Using the Internet" (— P182).

Available Communication Functions

Your FOMA handset supports the following 3 communication methods: 64K data
communications, packet communications and wireless LAN.

M 64K data communications and packet communications
You can choose between packet and 64K data communications for accessing the Internet.
Each communication method differs in the following points:

Communication Data rate Communication Access point
method charge
64K data 64 Kbps Charges based on FOMA/mopera 64K data communication
communications connection time. access points/ISDN synchronized 64K
access points
Packet Sending atupto 64 | Receiving at up to Charges based on the volume of data
communications | Kbps* 384 Kbps* transmitted.FOMA packet communication

access points (mopera, etc.)

*:  Data rate may decrease depending on the communication environment and network conditions.

B Wireless LAN

You can access the Internet via LAN. To do this, you have to make the wireless LAN setting. —

P392

Before Using the Internet

* When you use an Internet service provider other than mopera, monthly fee for the provider is required, in
addition to the FOMA monthly fee. For more information on monthly fee, contact your Internet service

provider.



¢ Please be aware that communications charges will be high when you use 64K data communications for long

duration.

* Please be aware that communications charges will be high when you use packet communications to transmit

large volumes of data such as when viewing websites with images and downloading data.

* Even when the connection conditions are satisfied, if the base station is congested or the radio wave status

is wrong, you may not carry out communications.

- -, L -—— -

Hinternet Glossary

Cache
The place where the FOMA handset temporarily stores data such as Web pages that you
have displayed. You can easily return to previously viewed Web pages because their data is
held in the cache for quick retrieval.

Gateway
A server that converts different communications protocols so that information can be
passed between heterogeneous devices on networks.

Subnet mask
A number that identifies the subnetwork where an IP address is shared by multiple
networks.

Primary DNS/Secondary DNS
A server address for searching domain names. "Primary" is a main server and "secondary"
is a secondary server.

Plain text authentication
The authentication method that identifies a user through plain text without encrypting data
for network communications.

Proxy server
A server that receives reguest from a browser and accesses to the Web server instead of
the browser.

cookies
The function that stores information in the FOMA handset memory and retrieves it when
necessary. For example, when you do shopping on the Internet, your fixed information such
as name or email address is stored in cookies for the first time. When you return to the
same Web site for shopping, the stored information appears automatically as the default
values.

DNS (Domain Name System)
The database system that translates a domain name address into an IP address.
For example, a numerical value "XXX. XXX.XXX.XXX" is translated into "XXX.com".

IP (Internet Protocol) address
A numerical value such as "XXX.XXX.XXX.XXX" that identifies a device connected to the
Internet, and is translated into a domain name by the DNS server. An IP address is
uniquely assigned to all devices connected to the Internet.

JavaScript
A program written in Java programming language. Generally, it is used for placing
emphasis on images.

PPP (Point to Point Protocol)
A protocol for transmitting data between 2 points.

VPN (Virtual Private Network)
A virtual private network that uses the Internet.
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Setting up the Internet

Before using the Internet, you have to set up the following connection settings.

Preparation Flow for Using the Internet

Vs

N
You are subscribing to an Internet service provider
ﬂ ) Yes
o . |:'|> N
Use mopera (no application required) — See below °
Subscribe to other Internet service provider
Store your ID and password in your FOMA handset in the
"Using an Internet Service Provider'— P185
< Internet is available >
J

Using mopera

172

DoCoMo's Internet connection service "mopera" allows you to use the Internet with a few simple
procedures.
B mopera Services

The following services are available:

mopera Net Surfing
You can easily access the Internet with no application and only pay communications charges. It is ideally

suited for users who want to browse Web pages quickly through your FOMA handset.

mopera mail
This service enables you to use email as well as various mail optional services. After making an

application for this service at a DoCoMo shop or by phone, you can easily make the mail settings with your
FOMA handset. = P226

mopera Quick Start Settings
With mopera Quick Start, you can store the connection information to mopera via packet or 64K
data communications in your FOMA handset.



Tap $$ » $$ in the Application Selector bar, and tap the
Connections tab ® Internet account on the Control panel screen

2 Tap Quick Start tab

M To check the Quick Start settings

* Usually, you do not have to change the settings.
Tap [Edit]. On the screen below, make necessary settings — tap [DONE].

Name : The profile name for Quick Start appears.
URL : Enter the URL for connecting to the Quick Start server.

* Tap [Advanced] to view the Quick Start settings. = P187 to P190

* Tap [Cancel] to cancel the setting.

3 Tap [Auto Setting]
4 Tap [Auto Setting], and tap [Yes] on the confirmation screen

* Tap [No] to cancel the setting.

5 Tap [Done]

19uIaY| .

173



l Using an Internet Service Provider I

| Default setting | Account name: mopera Bearer: Packet

To use the Internet without using mopera, you need to subscribe to an Internet service provider.

Please sign up for an Internet service provider in advance.

¢ For your FOMA handset, the mopera connection information (packet/64K data communications) are set by
default. If you use mopera Net Surfing only, no application or settings are required.

M Preparation for setting
Check the following information that your provider provides.

Bearer
The type of line (packet/64K data communications).

Account name
A name such as a provider name for confirmation. The official name is not required.

APN (Phone number)
A phone number used to establish the dial-up connection (Connection to the Internet by
dialling to an access point through a telephone line). Selecting an access point that
supports FOMA is required.

User name
A user name used to establish the dial-up connection to the Internet service provider.

Called differently by some providers.

Password
A password used to establish the dial-up connection to the Internet service provider. Called

differently by some providers.

Caller ID
The setting whether notify or not notify the Caller ID.

* The information necessary for connecting to the Internet such as items to set, item names or the value
may differ. For details on the information, contact your Internet service provider.

SENIE| '
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Tap $$ » $$ in the Application Selector bar, and on the Control
panel screen, tap the Connections tab ¥ Internet account.

M To edit the information you have set
Tap the account name » [Edit]
Perform the operation from Step 2 as needed.
M To delete the information you have set
Tap the account name » [Delete], and tap [Yes] on the
confirmation screen.
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2 Tap [New]

Account name : Enter a provider name, etc. to set.
¢ Up to 50 double- or single-byte characters
can be entered.
Bearer
FOMA CSD : Select this when using FOMA 64K data
communications.

GSM CSD : Select this when using data communications
in a GSM area.

Packet : Select this when using FOMA packet
communications.

WLAN : Select this when using a wireless LAN.

3 Tap Account name and enter a provider name, etc.

4 Tap Bearer and select between FOMA CSD/PACKET

rIWhen selecting FOMA CSD
New items are added below Bearer. Enter these items.

User name : Enter the user name used to connect to your Internet
service provider.

* Up to 256 double- or single-byte characters can be
entered.

Password : Enter the password used to connect to your Internet
service provider. Entered password is masked by
asterisks ("%").

* Up to 256 single-byte characters can be entered.

19uIaY| .

Phone : Enter a phone number of an access point of your
number Internet service provider.
* Up to 50 single-byte characters can be entered.
[ y
Tap [Advanced], and tap the tab to set on the Advanced setting
screen

¢ For each tab settings, see pages 187 to 190.

Modem Tab

‘ Default setting | User name: /Password: $$Username: -Password: -APN: -PDP TYPE: IP

You can make the settings for the IP (Internet Protocol) address and DNS (Domain Name
Server). Set necessary items according to the information provided by your Internet service
provider.
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In Step 5 on P186, tap Modem tab ¥ tap the item to set, and tap
[Done] after setting, and then tap [Done] on the Internet account

screen
User name and password
: Check when entering the User name/Password.

Before checking, the settings for User name/
Password are required.
$$ to enter, $$ not to enter.

User name

: Enter the user name used to connect to your
Internet service provider.
* Up to 256 double- or single-byte characters can
be entered

Password : Enter the password used to connect to your
Internet service provider. Entered password is
masked by asterisks ("*").
* Up to 256 single-byte characters can be entered.

APN : Enter the name of an access point of your Internet
service provider.
* Up to 32 double- or single-byte characters can

be entered
PDP TYPE : Set the protocol used to establish communications.
IP/DNS Tab

Get IP address automatically: $$IP address: 0.0.0.0Subnet mask: 0.0.0.0Gateway
address: 0.0.0.0Get DNS address automatically: $$Primary DNS address:
0.0.0.0Secondary DNS address: 0.0.0.0

Default setting

You can make the settings for the IP (Internet Protocol) address and DNS (Domain Name
Server). Set necessary items according to the information provided by your Internet service
provider.



In Step 5 on P186, tap IP/DNS tab » tap the item to set, and tap
[Done] after setting, and then tap [Done] on the Internet account
screen

Get IP address automatically
: Check when you assign the IP address to your
FOMA handset automatically on the network. If
you do not check this, the settings for IP
address/Subnet mask/Gateway address are
required.
$$ to assign, $$not to assign.
IP address : Enter the IP address.
* Enter 0 to 255 for each block.
Subnet mask : Enter the subnet mask.
* Enter 0 to 255 for each block.
Gateway address
: Enter the gateway address.
* Enter 0 to 255 for each block.
Get DNS address automatically
: Check when you assign the DNS address to
your FOMA handset automatically on the
network. If you do not check this, the settings
for Primary DNS address/Secondary DNS address
are required.
Primary DNS address
: Enter the main DNS address.
* Enter 0 to 255 for each block.
Secondary DNS address
: Enter the sub DNS address.
* Enter 0 to 255 for each block.

jauiau|

Proxy Tab

You can set the proxy server used to connect to the Internet via an intranet. Set necessary items
according to the information provided by your Internet service provider.
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In Step 5 on P186, tap Proxy tab® tap the item to set, and tap
[Done] after setting, and then tap [Done] on the Internet account

screen

Use proxy server
: Check when using the proxy server.
$$ to use, $$ not to use.
Auto proxy setting
: Check when getting the proxy settings automatically.
$$ to get, $$ not to get.
Auto proxy server address
: When Use proxy server/Auto proxy is set to $3$, enter the
address of the auto proxy server.
* Up to 50 single-byte characters can be entered.
Proxy server address
: When Use proxy server is set to $$ and Auto proxy is set
to $$, enter the address of the proxy server.
* Up to 50 single-byte characters can be entered.
Proxy server port
: When Use proxy server is set to $$ and Auto proxy is set
to $$, enter the address of the proxy server.
* The effective port is 0 to 65535.
Proxy exclusion
: When Use proxy server is set to $$ and Auto proxy is set
to $$, enter an URL requiring no connection to the
proxy server.
* Up to 256 single-byte characters can be entered.

Other Tab

You can make other settings required to connect to the Internet. Set necessary items according
to the information provided by your Internet service provider.



In Step 5 on P186, tap Other tab® tap the item to set, and tap
[Done] after setting, and then tap [Done] on the Internet account

screen

Setting Timeout

PPP Compression
: Check when executing PPP (Point to Point
Protocol) compression.
$$ to compress, $$ not to compress.
Plain text authentication
: Check when executing the plain text
authentication.
$$ to authenticate, $$ not to authenticate.
Caller number identification
: Set the Caller ID.
ON prefixes 186 and OFF prefixes 184
automatically. System setting is according to
the Caller ID setting (— P62).
* In FOMA CSD setting, no System appears.
Auto launch VPN
: Check if you enable VPN policy automatically
when starting connection. If you check this, the
settings for VPN policy are required.
$$ to enable, $$ to disable.
* When no VPN is installed or no VPN policy
is provided, you cannot set this item.
VPN policy : Select VPN policy that is enabled automatically
when starting connection.

You can set the time to automatically disconnect the Internet.

Tap $$ » $$ in the Application Selector bar, and tap the
Connection tab ® Internet account on the Control panel screen, and
then tap Other tab to make the settings on the Internet account

screen

Dial-up timeout
: Selects the duration between the dial-up
connection and automatic disconnection.
* If you do not automatically disconnect the
Internet, select [Never].
Packet timeout: Selects the duration between the packet
connection and automatic disconnection.
* If you do not automatically disconnect the
Internet, select [Never].

Tap the item to set and tap [Done]after setting

* Tap [Cancel] to cancel the setting.
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Opening Web Pages

You can open Web pages with simple operations. Before you can open Web pages, you have to

set up the Internet connection. -P182

Web Page Screen

Menu Bar

Content View Area

Scroll Bar
Icon name Icon Description
) Tab $$ Completed downloading all Web page data.
$$ Downloading Web page data.
$$ Completed downloading all SSL-enabled Web page data.
$$ Downloading SSL-enabled Web page data.
(@ Back $$ Returns to the previously displayed page (address).
(® Forward $$ After returning to the previous page by "Back", goes to the next page
(address).
(@ Stop/Refresh $$/$$ When loading a page, stops reloading. When not loading, updates the
current page to the latest.
(® Progress Bar $$ Appears during URL searching.
$$ Total data amount to download is unclear. Completed downloading.
$$ Total data amount to download is clear. Completed downloading.
$$ Downloading multiple data."Total number of data items/Number of

downloaded items" - "Downloaded data amount".




V=

HEMenu bar
Tap Browse or Edit on the Menu bar to display the following items:
Browse Edit
Openpage .. .....covvvvuvnen.. P201 COpPY. v P210
Closetab..................... P201 Paste ....... ... .. ... ... P210
Page information. .. ............ P202 Cut..... ... i P210
Find........ ... . i P203 Selectall. .................... P210
Bookmarks . ............ .. ... P204 Full-Screen................... P199
Savedpages. ................. P208 Landscape ................... P199
History ..... .. ... ... .. ...... P204 Fit-to-Screen. . .. .............. P199
Downloads ................... P211 ZOOM oot P141
Disconnect . .................. P195 Preferences .................. P214
* Some items might not be available depending on the operation.
- |
V B
HPopup menu
Point a blank part in the Content view area to display the following items:
LNk . P202
IMage . . P203 -
BaCK . . P197 5
FOIWAND. . . oo et e P197 )
REI0AT .« - .t ettt P198 2
Tab . P198
SOW . . e P199
- |

l Opening Web Pages via the Internet I

'I Tap $$ in the Application Selector bar

¢ |f your FOMA handset has already connected to the Internet,
the left screen does not appear.
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2 Tap Account name and select the account » Tap Connections

3 Tap the item (linked page)
Repeat Step 3 to open your desired Web page.

l Disconnecting the Internet l

While viewing the Web page, tap Browse® Disconnect % Yes on the
Menu bar

The Internet is disconnected.
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M Security communications
You can open Web pages compatible with SSL (Secure Sockets

Layer). SSL-enabled pages use data encryption for data

transmission to prevent hacking or impersonation so that you can

more safely exchange personal information such as addresses,

phone numbers and credit card numbers.

* To connect to SSL pages, the CA certificate is required. You can
check the content of the certificate as well as enable/disable it.

—P220
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Operations When Opening Web Pages

Basic operations when opening Web pages are as follows:

l Selecting Linked pages/Items l

HLink

An item used to go to related pages from the current Web page.
Tap your desired item to open the linked Web page.

M Text box

A box where you can enter characters.
Tap a text box to enter characters.
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HRadio button

Radio buttons are for selecting one of multiple options.
Tap $$ to change $$ to $$.
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B Check box

Check boxes are for selecting one or more items from multiple
options.
Tap $$ to change $$ to $$.

* |f you tap a marked box again, it becomes unmarked.

HEPull down menu

With pull down menus, you cannot see the choices until you
select a menu. Once selected, a list appears for further selection.
Tap a pull down menu. From a list, tap the item.

l Opening the Previous/Next Page I

You can return to the last Web page viewed or go to the next page.

$$ : The FOMA handset saves the last page you viewed. Tap
to return to the previous page.

$$ : The FOMA handset saves the next page. Tap to go to the
next page.




l Scrolling the Display l

While viewing Web pages, if the content of the page is larger than the display, you can scroll the
display to see the entire information.

Ml To scroll by dragging the Scroll bar

Drag the scroll bar to display the hidden part.

Ml To scroll by dragging the screen

Drag the screen to display the hidden part.

NOTE

* You can also scroll the screen with the Navigation key.

e
l Changing Tabs l

When multiple tabs appear, you switch the tab.

While viewing the Web page, point a blank part in the Content
view area, and tap 7ab ¥ the desired tab on the Popup menu

19uIaY| .
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l Reloading Information I

You can update the Web page information to the latest. If the Web page cannot appear due to
disconnection, etc., you may display the page by this operation.
$$ : Tap to reload the information.

¢ During reloading, tap $$ to stop reloading.

l Changing a Web Page View l

You can change the Web page view. Select one of the following 4 views:

Full-Screen Fit-to-Screen

Landscape

Zoom
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'I While viewing the Web page, tap Edit on the Menu bar

Full-Screen  : Displays a Web page in the original size. The
content of the Web page exceeds the display
area.
¢ When displaying in Landscape, you cannot

select this.

Landscape : Displays a Web page in the original size with
90-degree rotated to the right.

The content of the Web page exceeds the
display area.
¢ You can set the rotation direction. =P218

Fit-to-Screen : Displays a Web page to fit on the display size.
The content of the Web page is fixed to the
width of the display.

Zoom : Set the desired zoom level to change the
display size.

2 Tap a view

Ml To cancel the view you set
While viewing the Web page, tap Edit » the view with $$ on the Menu bar.

-

HEWhen selecting Zoom
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Drag $$ to change the zoom level— tap [Done]
¢ Set AutoZoom to $$ to automatically adjust the Web page size
when displaying, if the page supports this function.

M To display the Menu bar in Full-Screen/Landscape view

Point the screen and tap Menu bar in the Popup menu/press —=.
e v

NOTE

* Pressing also changes into Landscape view. Press again to return to the previous view.
¢ If you change a view, some Web pages may not appear.

Opening Web Pages by Entering URL

You can enter the URL to open your desired Web pages. You can also open the Web pages by
adding a new tab.
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'I While viewing the Web page, tap Browse » Open page on the Menu
bar

¢ Tap $$ on the right end of Location to list recently accessed
URLSs (up to 10 URLSs). You can open the Web page by
selecting the URL from the list.

* Tap [Cancel] to cancel the operations.

Bl To open Web pages by adding a new tab
Check [Open page in new window $$].
$$ to add, $$ not to add.

2 Tap Location, and enter an URL ®» tap [Open]

* Up to XX single-byte characters can be entered for an URL.

P
HTo close the tab you added

While viewing the Web page of the tab, tap Browse ® Close tab on the Menu bar

. v
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Viewing Web Page Information

While viewing the Web page, tap Browse % Page information on the

Menu bar
Title : Displays the title of the Web page.
Location : Displays the URL of the Web page.
Size of page : Displays the size of the Web page.
Security : Displays whether the Web page supports data
encryption.

HlTo copy the URL of the current Web page
Tap [Copy URL]
* How to paste. = P210
Bl To add a bookmark for the current Web page
Tap [Bookmark]
e Subsequent operations — P204
M To save the current Web page
Tap [Save]
¢ Subsequent operations — P207

2 Check the information and tap [Done]
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l Viewing Link Information I

While viewing the Web page, use 4-\1,-) to select the link, and point

a blank part in the Content view area and tap Lirnk on the Popup

menu
Ml To view the linked page

Tap [Open]
¢ Set[New tab] to $$ to view the linked page on the new tab.

Bl To copy the URL of the linked page
Tap [Copy URL]
* Subsequent operations = P210
Ml To add a bookmark for the linked page
Tap [Bookmark]
¢ Subsequent operations = P204

2 Check the information ant tap [Done]

l Viewing Image Information I

While viewing the Web page, point an image and tap Immage on the

Popup menu
M To view an image with the Image viewer
Tap [Open]
¢ Subsequent operations = P274
M To save an image in the FOMA handset
Tap [Save]
* Storage destination — P274
B To send an image

Tap [send]
¢ Subsequent operations = P310

2 Check the information ant tap [Done]
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Finding Text in Web Pages

'I While viewing the Web page, tap Browse » Find on the Menu bar

¢ Tap [Cancel] to cancel the operations.

Enter the characters to find, and tap [Direction] ([$$ Upl/[$$
Down]) » tap [Find]

Opening Web Pages from History

190

Web pages you viewed are saved in History. You can directly view the Web pages from History.

'| While viewing the Web page, tap Browse % History on the Menu
bar

M To clear History
Tap [Clear]
¢ Tap [Cancel] to cancel the operations.
* Tap [Open] to view the highlighted Web page.

2 Tap the Web page to view



Opening Web Pages Quickly by Adding Bookmarks

l Adding Bookmarks for Web Pages I

To return to Web pages you frequently view quickly, add bookmarks for the pages. Up to XXX
bookmarks can be added.

While viewing the Web page, tap Browse ®» Page information on the
Menu bar and tap [Bookmarks] on the Page information screen

¢ Tap [Cancel] to cancel the operations.

19uIaY| .

2 Tap Title and enter a title  tap [Add]

* Up to XX double- or single-byte characters can be entered for a title.

l Opening Web Pages from Bookmarks I

You can easily open Web pages from bookmarks you added.

'I While viewing the Web page, tap Browse » Bookmarks on the Menu
bar

2 Tap the bookmark for the Web page to view
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Editing Bookmarks

You can select and edit bookmarks you added.

'I While viewing the Web page, tap Browse » Bookmarks on the Menu

bar

2 Tap $$ of the bookmark to edit

7 Tap [DONE]

Location : Displays the URL of a bookmark to edit.
B To change the title of a bookmark
Tap Title and enter a new title
* Up to XX double- or singly-byte characters can be
entered.
H To send the URL of a bookmark
Tap [send]
¢ Subsequent operations — P310
M To delete a bookmark
Tap [Delete], and tap [Yes] on the Delete confirmation
screen

~

Deleting Bookmarks

You can select and delete bookmarks you added.

'I While viewing the Web page, tap Browse » Bookmarks on the Menu

bar

Tap $$ of the bookmark to delete

$$ changes into $$.

confirmation screen

* Tap [No] to cancel deleting.

Tap [Yes]

3 On the Menu bar, tap Browse® Delete, and tap [Yes] on the delete



Saving Web Pages Information

l Saving Web Pages I

You can save Web pages you might want to refer to later. Up to XXX pages can be saved. (The
maximum number of savable pages varies depending on the amount of data of the pages.)

While viewing the Web page, tap Browse ®» Page information on the
Menu bar, and then tap [Save] on the Page information screen

¢ Tap [Cancel] to cancel the operations.
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2 Enter the title » tap [Save]

* Up to XX double- or single-byte characters can be entered for a title.

l Opening Web Pages You Saved I

You can select and open Web pages you saved.
While viewing the Web page, tap Browse » Saved pages on the
Menu bar

2 Tap the Web page name to view
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l Editing Web Pages You Saved I

You can select and edit Web pages you saved.

While viewing the Web page, tap Browse ¥ Saved pages on the

Menu bar

2 Tap $$ of the Web page to edit

3 Tap [Done]

Size of page : Displays the file size of the Web pages you
saved.

Last modified : Displays the date when you saved the pages.
Ml To change the title

Tap Title and enter a new title

¢ Upto XX double- or single-byte characters can be entered
for a title.

M To delete the Web page

Tap [Delete], and tap [Yes] on the Delete confirmation

screen

l Deleting Web Pages You Saved I

You can select and delete Web pages you saved.
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While viewing the Web page, tap Browse » Saved pages on the
Menu bar

2 Tap $$ of the Web page to delete
$$ changes into $$.

3 On the Menu bar, tap Browse® Delete, and tap [Yes] on the delete
confirmation screen

* Tap [No] to cancel the operations.
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Copying/Cutting and Pasting Text in Web Pages

You can copy, cut and paste characters you entered or the content of Web pages into other entry
screens.

l Copying/Cutting I

'I Drag the area to copy » tap Edit%» Copy/Cut on the Menu bar,

The copied/cut information is stored in the clipboard.

Ml To copy/cut all information on a page
(@ Tap Edit ¥ Select all on the Menu bar
The all information on the screen is selected.
(2) Tap Edit¥ Copy/Cut on the Menu bar,
The copied/cut information is stored in the clipboard.

NOTE

* A memory area where copied/cut information is stored. The clipboard stores a copy of the last information
that was copied or cut. Copying/cutting other information overwrites the data stored in the clipboard. Turning
the FOMA handset off or resetting the settings also clears the data in the clipboard.
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Tap the position to paste the data, and tap Edit % Paste on the
Menu bar

l Pasting I
1

Downloading Data from Web Pages
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You can download various applications from the Internet. You can also delete data you
downloaded later.

'I While viewing the Web page, tap the item to download

$$ : Data being downloaded.
$$ : Data that is suspended during downloading.
$$ : Data that has been downloaded.

2 Downloading completes

NOTE

¢ Installing data you downloaded — P268

|
l Installing Ring Tone Files I

You can install downloaded ring tone files as ring tones.

'I Tap the ring tone file to install on the Download data list screen

$$ : Stops audio

$$ : Plays back audio.

M To delete a ring tone file
Tap [Delete]

B To save a ring tone file in the FOMA handset
Tap [Save]

2 Tap [Install ring tone]



l Viewing Downloaded Data Information I

You can view details on data you downloaded.

'I Gap $$ of data to view on the Download data list screen

name : Displays a name of the data.
Current size : Displays the size of the current file.
Total size : Displays the total size of the files.
Location : Displays the URL of the source file.
Date : Displays the date of the data created.

2 Check the information and tap [Done]

l Deleting Downloaded Data I

You can select and delete data you downloaded.
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'I On the Download data list screen, tap $$ of data to delete
$$ changes into $$.

2 Tap Browse® Delete on the Menu bar, and tap [Yes] on the delete
confirmation screen

* Tap [No] to cancel deleting.

Using Phone To/Mail To/Web To Functions

By tapping highlighted information (a phone number, email address, or URL) on a Web page/
email screen, you can make a call, send a message or open a Web page.

l Using Phone To Function l

By tapping a phone number, etc. on a Web page/email, you can make a call.

197



'I Tap a displayed phone number, etc.

2 Tap [Dial)/[Video Call]
* Subsequent operations — P66, P86

NOTE
* Phone To function may not be available depending on Web pages.

Using Mail To Function

By tapping an email address, etc. on a Web page/email, you can send an email message.
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'I Tap a displayed email address, etc.

The email composing screen with the email address entered
appears.

¢ Subsequent operations — Step 3 on P235

NOTE
¢ Mail To function may not be available depending on Web pages.

Using Web To Function

By tapping an URL, etc. on a Web page/email, you can open a Web page.

'I Tap a displayed URL, etc.

NOTE
* Web To function may not be available depending on Web pages.
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Setting Web Browser Preferences

You can make various browser settings.

'I While viewing the Web page, tap Edit ® Preferences on the Menu
bar

2 Tap the tab to set
* For each tab settings, see pages 215 to 219.

General Tab

Default setting | Choose encoding: Automatic selection Fallback: Shift-JIS HTTP Timeout: 60
seconds Homepage: Blank

On the General tab, you can set various browser settings including the character code for the
browser, the time to connect, and the default homepage.

In Step 2 on P214, tap General tab ¥ tap the item to set, and tap
[Done] after setting

Choose encoding
: Set the normal character code.
Fallback : Set the spare character code.
HTTP Timeout
: Some Web pages require a while to open. Set
the time before the FOMA handset stops
opening the Web page.
Homepage : Enter the URL for the default home page.
* Tap [Use current] to set the current Web page
to the default.
¢ Tap [Blank] to set the blank page to the default.

NOTE

¢ Usually, Choose encoding should be set to Automatic selection. However, some Web pages may display
characters in correctly. In this case, changing into other option may display characters correctly.
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Cache Tab

| Default setting | Cache size: $$ Small Use cookies: Always ‘

On the Cache tab, you can set cache and cookies for the browser.

In Step 2 on P214, tap Cache tab ¥ tap the item to set, and tap
[Done] after setting

Cache size:
$$ Small . Allocates the small cache size.
$$ Large : Allocates the large cache size.
Use cookies:
Always : You can use cookies when viewing cookie-
enabled Web pages.
Never : You can never use cookies when viewing
cookie-enabled Web pages.
Ask : You can select how to use cookies on the

confirmation screen when viewing cookie-
enabled Web pages.

Cache [Clear] : Tap to clear the cache data.

Cookies [Clear]: Tap to clear the cookie data.



Multimedia Tab

On the Multimedia tab, you can set the operations of images, animations and sound effects.

In Step 2 on P214, tap Multimedia tab » tap the item to set, and
tap [DONE] after setting

Load all images$$
: Set whether display images or not when

viewing Web pages with images.
$$ to display, $$ not to display.

Enable animations$$
: Set whether play back animations or not when

viewing Web pages with animations.
$$ to play back, $3$ not to play back.
Enable javascript $$
: Set whether enable JavaScript or not when
viewing Web pages with JavaScript. $$ to
enable, $$ to disable.
Ignore refresh $$
: Set whether enable the automatic refresh of
Web pages or not.
$$ to enable, $$ to disable.
Enable BGSound $$
: Set whether enable sound effects or not when
viewing Web pages.
$$ to enable, $$ to disable.

jauiau|
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Display Tab

On the Display tab, you can set how to show frames and popups.

In Step 2 on P214, tap Display tab ¥ tap the item to set, and tap
[Done] after setting

Plug-ins Tab

Landscape Rotation
Lefthand : Rotates the Web page to the left in
"Landscape" view (— P199).
Righthand  : Rotates the Web page to the right in
"Landscape" view (— P199).
Show frames as
All frames  : Displays all frames when viewing frame-
enabled Web pages.
List of frames: Displays a list of frames when viewing frame-
enabled Web pages.
No frames : Displays no frames even when viewing frame-
enabled Web pages.
Horizontal scrollbar

Auto : Displays the Horizontal scrollbar when viewing
the Web page larger than the display screen.

ON : Always displays the Horizontal scrollbar.

OFF : Displays no Horizontal scrollbar.

Vertical scrollbar

Auto : Displays the Vertical scrollbar when viewing the
Web page larger than the display screen.

ON : Always displays the Vertical scrollbar.

OFF : Displays no Vertical scrollbar.

Block popups

Don't block : Displays popup windows when viewing popup-
enabled Web pages.

Block all : Displays no popup windows when viewing
popup-enabled Web pages.

Allow user requested popups

: You can select whether display popup windows

on the confirmation screen when viewing
popup-enabled Web pages.

You can check plug-ins installed in the browser.



'I In Step 2 on P214, tap Plug-instab, and tap [Done] after checking

The list of installed plug-ins appears.
* Tap the plug-in name to view the plug-in information.

NOTE
¢ What is cache, cookies, and JavaScript? — P181

When an Incoming Call Arrives during Internet Connection

19uIaY| .

<<Comment>> <Insert later >

Using Certificates

Checking User/CA Certificates

You can check the certificates required for establishing security communications.

Tap $$ » $$ in the Application Selector bar, and tap the Handset
tab ¥» Certificate manager on the Control panel screen, and then
tap the User tab/Certificates tab on the Certificate list screen

List of user certificates List of CA certificates

2 Tap the certificate name » tap [Details]

203



H About the Certificate
User certificates : Digital data that identifies users. Using user certificates
provides you easier and more secure user authentication than
normal one that requires the entry of user ID and password.
CA (Certification Authority) : The certificate issued by the certifier. It is stored in your FOMA
certificates handset by default.
. W

Deleting Certificates

You can delete User certificates.
¢ You cannot delete CA certificates.

Tap the certificate name on the User certificate list screen » Tap
[Delete]

NOTE
* If you delete a user certificate, the corresponding Web pages no longer appear.

SENIE| '
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"Internet mail (hereafter "email") via general network service providers is available on FOMA
handset.

To use email, you are required to subscribe the mopera email service (— P226) or network
service providers supported by FOMA, and to set Internet connection (— P185) and email
account (— P228).

@Files can be attached to outgoing @Emails can be automatically
emails — P246 received — P231, P243
Files saved in your FOMA handset can You can set your FOMA handset to
be attached to outgoing emails. receive incoming emails automatically

or at a specified time.

@Incoming emails can be sorted to @ Messages can be sent/received
specified folders — P257 using Short Message Service (SMS)
Incoming emails can be sorted to — P261, P263
specified folders by using the sender's SMS messages can be exchanged
email address or subject of the among other FOMA handsets.

message as a sorting key.

Number of Characters/Attachments that can be Sent/Received

Buibessapy '

ltem Send Receive

Destination address | Up to XX addresses including To, Cc, and
Bcc (up to 1000 single-byte characters per -
email)

Subject Up to 1000 characters regardless of Up to XXXX characters regardless of
double- or single-byte double- or single-byte

Body text Up to 65536 characters regardless of Up to XXXX characters regardless of
double- or single-byte double- or single-byte

Attachment Up to XX files, less than (or equal to) XX | Up to XX files, less than (or equal to) XX
bytes in total bytes in total

Receiving Emails

Receiving emails with your FOMA handset requires connection to the mail server of your network
service provider. You can set your FOMA handset to automatically receive emails.
* Connecting to mail server to receive emails — P243

NOTE
* Deco-mail/HTML messages can be received except the messages that contain JavaScript or Flash images.
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About Short Message Service (SMS)

Short Message Service (SMS) allows you to exchange text messages among other FOMA
handsets. Subscription to network service providers is not required for this service.
¢ Sending/receiving SMS messages — P261, P263

NOTE

* Text messages cannot be sent/received from overseas by using Short Message Service (SMS).
¢ The received SMS messages in your FOMA handset can be saved to a UIM. — P265

SMS Message Destination Address

A "subscriber's mobile phone number" is used as the destination address for sending a SMS
message.

Number of Characters That can be Sent/Received

The number of characters that can be sent/received using Short Message Service (SMS) is as
shown below:

Item Double-byte characters (kaniji, Single-byte characters (alphanumeric
hiragana, etc.) characters, etc.)
Destination address - 20 (numerals only)
Body text 70 160*
* \J\g;zn only single-byte alphanumeric characters or symbols (excludingo [ J {}[1 . -~ ° =~ " )are

When FOMA handset fails to receive SMS Messages

SMS messages that arrive at the Short Message Center are immediately sent to your FOMA
handsets. However, in case of your FOMA handset is powered off, out of the service area, etc.,
the messages are stored at the Center.

NOTE

¢ The maximum time of SMS messages to be stored at the Short Message Center is 72 hours. You can specify
the retention time in "SMS retention time" (— P266).

* SMS messages are deleted when the retention time has elapsed.

¢ SMS messages stored at the Short Message Center can be received by Check for new SMS (— P263).

* When FOMA handset received SMS messages, the SMS messages stored at the Short Message Center
are deleted. The received SMS messages are saved in FOMA handset. = P264

Buibessay .
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HETerminology for email

IMAP
IMAP (Internet Message Access Protocol) is a protocol for receiving emails from storage
servers. In this method, emails are managed in a mailbox on the servers and recipients can
determine to receive or discard the emails after checking subjects and senders.

POP
POP (Post Office Protocol) is a protocol for receiving emails from storage servers. This
method is widely used in pair with the protocol for sending emails called SMTP. Unlike
IMAP, recipients receives all emails and unable to check the lists of senders or subjects
before mail reception.

SMTP
SMTP (Simple Mail Transfer Protocol) is a protocol for sending emails, which allows email
exchange between servers or sending of emails by users.

Using Mopera Email Service

| This service requires a separate subscription. |

Once you make a subscription at a DoCoMo shop or by phone, you can make email settings
easily with the handset. Either of the following services can be selected according to your need:
mopera POP Mail (400 yen/month (420 yen including tax))
* Separate communication charges apply.
This standard email service allows you to enjoy full-fledged messaging at reasonable
charges.

mopera IMAP Mail (1400 yen/month (1470 yen including tax))

* Separate communication charges apply.
This high-end service is recommended to users who exchange many emails, frequently
exchange large emails, or use the same email address from different handsets. The subjects
of emails can be checked to allow users to select and retrieve only emails they want to read,
which makes the service convenient for mobile use.

l Quick Start l

Quick Start automates the setting of connection required for mopera email service for easy
messaging setup.

Tap $$ » $$ in the Application Selector bar, tap Connect tab »
Internet account in the Control panel screen, and tap Quick Start tab
in the Internet account screen



2 Tap [Auto Configure]

3 Tap [Yes], and tap [Yes] in the confirmation screen

m
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Settings Required for Using Email

Internet access point setting (— P182) and email account setting (see below) are required to
use email. For setting information, see documents provided by your network operator.

e )
You have an email address

| L=

You are already using mopera Subscribe to mopera email service
email service — P226 — P226

. | s 1 1

Use Quick Startfor ~ Youare subscribing  Subscribe to another Use Quick Start for
setting to another network  network operator setting
operator

Perform Internet access point settings — P182

Perform email account settings — See below

Buibessapy '

C Email is available >

- J

l Performing Email Account Settings I

Settings are required for sending/receiving emails.

'I Tap $$ » $$ in the Application Selector bar, and tap Connect tab
®» Messaging account in the Control panel screen

M To edit an email account
Tap the account to edit » Tap [Edit]
Perform Step 3 and operations that follow as required.
M To delete an email account
Tap [Delete], and tap [Yes] in the Confirm delete screen

212



2 Tap [New]

3 Tap the tab to set
¢ On how to set the individual tabs, see P229 to P234.

Basic Tab

Default setting | Account name: - Owner name: - Email address: —
Connection type: POP3 Internet account: -

The account name, email address, Internet account used for connection, etc. are set up.

Tap Basic tab in Step 3 on P229 » Tap the field for the item to set
up » Tap [Done] after setting

Account name
: Set the account name to be displayed on the
messaging account list.
* Up to 90 double-or single-byte characters can

be entered.
Owner : Set the name, etc. of the person who uses the
account.
* Up to 90 double-or single-byte characters can
be entered.
Email address: Set the email address to be used for this
account.
* Up to 90 single-byte characters can be
entered.
Connection type
IMAP : Specify settings to connect to a mail server that
supports IMAP.
POP3 : Specify settings to connect to a mail server that

supports POP3.
Internet account
: Set up the Internet account to use for sending/
receiving emails.

Buibessay .
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Password Tab

Default setting | Inbox username: - Inbox password: - Use SMTP authentication: $$
Use inbox login details: $8 Outbox username: - Outbox password: -

Set the username, password, etc.

Tap Password tab in Step 3 on P229 ®» Tap the field for the item to

set up »Tap [Done] after setting

Inbox

Outbox

Inbox username : Set the username for this email account.

* Up to 90 single-byte characters can be
entered.

Inbox password : Set up the password for this email account.

The entered password is masked with "%."

Use SMTP authentication

: Select if SMTP server authentication is
required. To select this, Inbox username and
Inbox password must be set.
$$ indicates use of SMTP authentication
and $$ non-use.

Use inbox login details

: Select this to use the username and
password for inbox SMTP authentication
also for outbox.
$$ indicates use of the same username and
password and $$ non-use.

Outbox username

: Set the username for inbox SMTP
authentication.
* Up to XX single-byte characters can be
entered.

Qutbox password

: Set up the password for inbox SMTP
authentication. The entered password is
masked with "¥".




Inbox Tab

‘ Default setting | Incoming server address: - Download: Only headers Size: 1KB No. of lines: 0 ‘

Set the incoming server address and the method of receiving emails.

In Step 3 on P229, tap Inbox tab » Tap the field for the item to set
up » Tap [Done] after setting

Incoming server address
: Set the address of the incoming mail server (POP3/
IMAP).
* Up to 90 single-byte characters can be entered.
Download
Only headers
: Set this to receive only the subjects of emails. Body text
or attachments are not received.

Size : Specify the size of an email to receive. Size must be set.
No. of lines

: Specify the number of lines in an email to receive. No. of
lines must be set.
No restrictions
: Set this up to receive emails as they are.
Size : Set up the size of an email.
* Any size in the range of 1 to 99999 KB can be used
for setup.
No. of lines
: Set the number of lines in an email.
¢ Any number can be set within the range of 0 to 999.

Buibessay .
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B Scheduling email checking
Set your handset to automatically connect to the mail server to check for any incoming email
at scheduled timings.

Tap [Schedule]

Schedule download
: Select this to use the schedule to receive emails.
$$ indicates use of the schedule and $$ non-use.
$$ Set time: Select this to specify the time to receive emails. To set this, Check email at must
be set.
$$ indicates use of time specification to receive emails and $$ non-use.
$$Set interval
: Select this to specify the interval to receive emails. To set this, Check email every
must be set.
$$ indicates use of interval specification to receive emails and $$ non-use.
Check email at
: Up to 3 different times of the day can be specified to automatically check any
incoming email.
Check email every
: The interval can be specified for automatically check any incoming email.

Outbox Tab

| Default setting | Outgoing server address: — ‘

Set the outgoing server address.

Tap the Outbox tab in Step 3 on P229 » Tap the field for the item
to set up®» Tap [Done] after setting

Outgoing server address: Set up the SMTP server address.
* Up to 90 single-byte characters
can be entered.




Advanced Tab

Default setting | Outgoing security: not specified Outgoing mail port: 25 Use MIME encryption: $$
Incoming security: Not specified Incoming mail port: 110 Secure password authentication: $$
Delete from server: $$

Perform settings related to mail server security, etc.

Tap the Advanced tab in Step 3 on P229 » Tap the field for the item
to set up » Tap [Done] after setting

Outgoing security : Specify the use of SSL communication for
sending emails.
Outgoing mail port: Set the outgoing mail port number.
* Any number within the range of 0 to
65535 can be used for set up.
Use MIME encryption
: Select this to use MIME encryption to send
emails.
$$ indicates use of MIME and $$ non-use.
Incoming security : Specify the use of SSL communication for
receiving emails.
Incoming mail port: Set up the incoming mail port number.
¢ Any number within the range of 0 to
65535.
Secure password authentication
: Select this to encrypt the password to send
to the server.
$$ indicates use of encryption and $$ non-
use.
Delete from server: Select this to delete emails from the server
when they have been delivered.

Buibessay .
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Email notification Tab

Default setting ‘ Automatic download: XXX

Specify the use of email notification before receiving when any email has been delivered to the
specified account.

Tap the Email notification tab in Step 3 on P229 » Tap the field for
the item to set up » Tap [Done] after setting

Automatic download
: Select this to get notified of an incoming email
before receiving it.
$$ indicates use of notification before receiving
and $$ non-use.
IAP selection: Use this function to specify the account for
receiving emails.

Viewing Messaging Account List

This screen lists the email accounts that have been set up and allows you to use various
messaging functions.

Buibessapy '

'I Tap $$ in the Application Selector bar

(1) Messaging service type
$$ : email
$$ : Short Message Service (SMS)
(@ Account name
(® No. of unread emails
(@ No. of unsent emails

MItems available from the Menu bar on the messaging account list screen A
Tap Message or Edit on the Menu bar to display items as shown below:
Browse Edit
Find ........ ... P247 ZOOM it P141
Receive &send . .............. P243 Preferences .................. P260
* Some items may not be available depending on the operation.
[ V|
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Composing and Sending Email

Compose and send a new email.

Tap $$ » account name to use in the Application Selector bar,
and tap [New] in the message list screen

$$ : Tap to enter the destination address (Cc, Bcc), etc.
— P239
$$ : Tap to attach a file — P240

2 Tap To and enter the destination address

* Specifying a recipient from the contact list ~ P238

* More than one recipient can be specified by separating email
addresses with ", (commas)".

3 Tap Subject and enter the subject

¢ Up to 1000 double - or single-byte characters can be entered.

* Up to 1000 double - or single-byte characters can be entered.

Buibessay .
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4 Tap the text field and enter text

* Up to 65536 double or single byte characters can be entered.
* Adding contact — P239

5 Tap [Send]

¢ Tap $$Save to outbox to save the composed message in outbox
without sending it.

Tap $$Send immediately % [Done]

The Connect to mail server screen is displayed and the email is sent after connection has

been established.

* Tap [Cancel] in the Connect to mail server screen to cancel sending. However, sending
may not be canceled depending on the timing.

Buibessapy '

rlltems available from the Menu bar h
Tapping Message or Edit in the Menu bar in the Create email screen displays items as shown
below:

Message Edit
New ... P235 Cut. ... P249
Attach yourcard............... P242 COPY « v P249
Find ................... P247, P248 Paste.......... ... ... .. ..... P249
Findnext .................... P248 Selectall ..................... P249
Deletemessage............... P259 Selectcontact ................. P239
Disconnect. .................. P195 Setzoomlevel................. P141
Preferences................... P260
* Some items may not be available depending on the operation.
A V|

NOTE

¢ Text input method — P466
\___________________________________________________________________________/4
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l Specifying a Recipient from the Contact List I

From the Create email screen, search for an email address stored in the contact list and insert it.
A recipient whose email address is not stored cannot be specified.

Tap 7o in the Create email screen, and tap $$ of the recipient to
search for » [Done] in the Select contact screen

¢ |f you have selected contact data containing more than one
email address, go on to select another email address.
* Tap [Cancel] to cancel the operation.

l Displaying Contact List to Create Emails I

The Create email screen can be displayed from the contact list screen. This operation cannot be
performed for a contact whose email address is not stored.

'I Tap an email address in the contact list screen

» Displaying the contact list screen — P107
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Adding Destination Address (Cc, Bcc)

Adding one or more destination address allows you to send an email containing the same
message to more than one recipient at one time.

'I Tap the $$ tab in the Create email screen

To : Enter the recipient's email address. A message with no
destination address specified in To cannot be sent.

Cc : Enter a destination address to send the message to in
addition to 7To.

Bcc  : Enteranintended recipient whom you want to hide from

the recipient specified in To or Cc. The entered email
address will not be visible to the other recipients.

2 Tap To/Cc/Bcc and enter the destination address

* Up to 1000 single-byte characters can be entered.
* Specifying a recipient from the contact list — P238

NOTE

¢ Text input method — P466
¢ Inthe To/Cc/Bcc field, more than one recipient can be specified by separating email addresses with *,
(commas)".

"
l Inserting Contact Data to Email Body Text I

Information stored in the contact list can be inserted to email body text. This function is useful for
sending contact information by email, etc.

Buibessapy '

'I Tap Edit % Select contact on the Menu bar in the Create email
screen, and check $$ of the recipient to add in the Select contact
screen » Tap [Text]

e Tap Select all $$ to check all items.
2 Check $$ of the item to send » Tap [Done]

The contact data are inserted to the email body text.
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l Setting Priority for Email I

QOutgoing emails can be assigned priorities according to their contents.

'I Tap the $$ tab ®» Priority in the Create email screen

High : Assign this to emails containing important messages
that you want the recipients to read without fail.

Normal: Assign this to emails containing messages of average
importance not much affected by priority.

Low : Assign this to emails containing messages of no
particular importance that may be read later.

2 Select a priority

Attaching Files

Voice, video, image and document files, etc. saved in your FOMA handset can be attached to
outgoing emails.

Buibessay .

Tap the $$ tab ®» [Add] in the Create email screen, and tap Type in
the Add attachment screen

Voice : Select from voice memos, etc., recorded on the FOMA
handset.
Video : Select from video clips captured with the FOMA
handset or downloaded from websites, etc.
Image : Select from still images captured with the FOMA
handset or downloaded from websites, etc.
Document
: Select from document files (Word or Excel files, etc.).
Other : Select from all stored files.
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2 Select the type of the file to attach » Tap [Execute]

MIf Voice has been selected

Select the folder containing the intended file.
Files available as attachments are listed.
A file can be selected and played/stopped.

If Video has been selected

Select the folder containing the intended file.
Files available as attachments are listed.

If Image has been selected

Select the folder containing the intended file.
Files available as attachments are listed.
The view of the list can be changed.

If Document has been

selected

Select the folder containing the intended file.
Files available as attachments are listed.

If Other has been selected

Select the folder containing the intended file.
Files available as attachments are listed.

3 Tap the file to attach » Tap [Select]



—_—_—eeeeeeeeeeeeeeeeeeeeeee
M To delete attachment

@ Tap the $$ tab in the Create email screen #» Tap $$ of the attachment to delete
$$ is switched to $$.
(2 Tap [Delete]

l Attaching vCard I

Contact data can be attached as they are to outgoing emails.

'I Tap Message W Attach your card on the Menu bar in the Create email
screen

¢ Tap the $$ tab in the Create email screen to display the vCard attached for confirmation.

Saving Unfinished Emails for Sending Later

I Saving Unfinished Emails I

Emails in the process of creation or editing can be saved to unsent box.

Buibessay .

'I Create an email in the Create email screen » Tap $$

l Editing/Sending Saved Emails I

Unsent emails saved in the handset can be edited for sending.

Tap Inbox” % Outbox/Unsent box on the Menu bar in the Create
email screen

*: The name of the previously selected mailbox is displayed.

Unsent email list screen
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2 Tap the email to edit

Go to Step 2 on P235.
-_—
M Selecting and sending an email
If you have more than one email to send, you can select from them for sending.

Select $$ of the email to send on the message list screen » Tap [Receive & send]
€ 4

Connecting to Mail Server to Receive Emails

You can connect to the mail server of your network operator to receive emails.

Tap $$ in the Application Selector bar, and tap Message » Receive
& send on the Menu bar

Connect to the mail servers of all messaging accounts beginning

with the first one displayed on the messaging account list screen

to check for any incoming emails.

¢ Tap [Cancel] to cancel receiving emails. However, receiving
may not be canceled depending on the timing.

2 Receiving email

N
M To select an account before receiving emails

Tap the name of the account for which you want to retrieve emails on the account list screen,
and tap [Receive & send] on the message list screen.

* [Receive & send] is not displayed on the unsent email list.
[ V|

—_—_—eeeeeeeeeeeeeeeeeeeeeeee
M To disconnect

Tap Message % Disconnect on the Menu bar in the menu list screen.
A V|




HIf you are using an account with Email notification (— P234) set up
When any email is delivered to the server, notification is sent automatically to your FOMA
handset and the email is retrieved without explicit connection to the mail server.

HIf you are using an account with Schedule (— P232) set

Connection is automatically made to the mail server at the specified time/interval for retrieving
emails.
A V|

Replying to Emails

You can reply to the sender of an incoming email or SMS message.

'I Tap Reply in the incoming email details screen

Hl To reply to an email with more than one address
(D Tap Message » Reply to all on the Menu bar in the
incoming email details screen
(@Enter the subject and send an email

Go to Step 3 on P235.

NOTE

* You cannot reply to an SMS message showing User unset, Payphone, Not supported as the sender.
¢ A Short Mail message sent from a mova i-mode handset to a FOMA handset is received as a SMS message
but it is not possible to reply to it.

Buibessay .
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Forwarding Emails

Incoming emails or SMS messages can be forwarded to other people.

Tap Message » Forward on the Menu bar in the incoming email
details screen

2 Enter the destination address and send an email
Go to Step 3 on P235.

Managing Sender Email Addresses and Phone Numbers

Buibessapy '

l Storing in Contact List l

Senders of incoming emails or SMS messages can be stored in the contact list.

Tap Sender in the incoming email details/outgoing email details
screen
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2 Tap [Save contact]

3 Tap First namelLast name and enter the names

* Entering other information — P99

l Making a Call to Sender I

You can make a call to the sender of an incoming SMS message.

Tap Sender in the incoming email details/outgoing email details
screen

2 Tap [Call}/[VideoPhone]
* For operations that follow — P66, P86

9
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Searching Emails

Search the emails/SMS messages stored in the FOMA handset for any email/SMS message that
contains the specified keyword, and list the messages.

Tap Message » Find on the Menu bar in the account list/message
list screen

Enter a keyword. You can select an account for the search.
* Up to 128 double or single byte characters can be entered as
a keyword.

Tap a text input field and enter a keyword » Tap Where? and
select the account to search » Tap [Find]

3 Tap the email to view



Searching Text Strings in Emails

Tap Message % Find on the Menu bar in the message details/
Create email screen

Tap a text input field and enter a text string to search for $» Tap
the direction (@l@) » Tap [Find]

* Tap [Cancel] to cancel the search.

M To search for the same text string successively

[

Tap Message ¥ Find next on the Menu bar in the message details/Create email screen
v
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Copying/Cutting and Pasting Strings in Emails

You can copy or cut text strings entered or body text of emails and paste on other entry screens,
etc.

Copying/Cutting

'I Drag to select the text to copy » Tap Edit ® Copy/Cut in the Menu
bar

The specified text is saved on the clipboard.

M To select all to copy/cut
(@ Tap Edit ¥ Select all in the Menu bar
All strings in the selected item are selected.
(2) Tap Edit % Copy/Cut in the Menu bar
The strings are saved on the clipboard.
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Pasting

'I Tap the area you want to paste to, and tap Edit % Paste in the Menu
bar

The copied/cut text is pasted.

NOTE

* The clipboard is a memory area for temporarily holding what you have copied/cut. Only one piece of
information can be held, which is overwritten when another has been copied/cut. Information held on the
clipboard is erased when the handset has been switched off or settings have been reset.

Managing Files Attached to Emails

Attachments can be viewed/played and saved.

'I Tap the $$ tab in the message details screen




2 Tap the attachment
W Audio file

HVideo file

HMImage file

HEDocument file

233
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————————————————————————————————————
HMSaving attachments
Tap [Save] on the screen in Step 2

M Audio file HMImage file

M Video file HDocument file

(-

NOTE

* Tap an unreceived attachment to display the confirmation screen. = P254
"

A

Viewing Messages on Email/SMS Message List Screen

You can view messages saved in inbox/unsent box/outbox/sent box for each accounts.
Up to XX messages can be saved in inbox, XX messages in unsent box, XX in outbox, and XX in
sent box.

<Example: incoming message>



Tap the messaging account for which you want to view
messages on the account list screen

List screen (subject not List screen (subject Details screen
displayed) displayed)
(@ Account name: No. of messages in folder
(2 Checkbox to use for deletion — P259
(3 Message type
$$: Standard message
$$: Message with attachment
$$: Only the number of messages received/messages including unreceived data

(@ Sender phone number/email address (inbox), recipient phone number/email
address (outbox/unsent box/sent box)

If the phone number or email address is stored in the contact list, the name is displayed.

(3 Subject
For a SMS message, the beginning of the body text is displayed. SMS is displayed on the
details screen.

(6 Time/date sent/received
Time is displayed for emails or SMS messages sent/received on the day, and date is
displayed for those sent/received prior to the current day.

(@ Size of message

Body Text (SMS)

(@ Create new message
Tapping this allows you to create a message. = P235

Receive & send (inbox/unsent box/sent box)/Send (outbox)
Tapping this allows you to receive and send/send a message. = P243

Buibessapy

235



Buibessapy '

236

[

M To switch between mailboxes to view
Tap Inbox” % mailbox to view on the Menu bar

*.

The name of mailbox previously viewed is displayed.
V|

2 Tap the message to view on the email/SMS message list screen

Tap the $$, $3$, or $$ tab to switch between views.
¢ On the unsent mail/SMS message list screen, the Edit screen (— P243, P262) is
displayed.

Text screen Recipient details screen Attachment screen
(@ Subject
(@ Sender
(3 Body text
(@ Destination other than sender
(6 Time/date received
(® Size of message
(@ Message priority
Checkbox to use for deletion
(@ Attachment file type

$$: Audio file
$$: Image file
$$: Video file
$$: Document file

Sender phone number/email address (incoming message), recipient phone
number/email address (outgoing/unsent/sent message)
If the phone number or email address is stored in the contact list, the name is displayed.
1) Subject
For a SMS message, the beginning of the body text is displayed. SMS is displayed on the
details screen.
(12 Time/date sent/received
Time is displayed for emails or SMS messages sent/received on the day and date is
displayed for those sent/received prior to the current day.
(13 Body text



HViewing the details screen for messages with unreceived data for a POP3 account
Tap [Yes]
All unreceived data will be received.

HViewing the details screen for messages with unreceived data for an IMAP account
Tap [Yes]
Unreceived message data will be received.
Download attachment $$
: Select to receive attachment together with the message.
$$ indicates receiving of attachment and $$ non-receiving.

e v
~
B Receiving unreceived attachments to messages for an IMAP account
Tap the attachments to display the screen as shown below:
Tap [Yes]
Attachments will be received.
V|
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Hitems available on the Menu bar in the message list screen
Tapping Message or Edit in the Menu bar displays items as shown below:

Message
New ... ... i P235
Find ................... P247, P248
Copyto........ovviiiat. P256
Move ........ ... ... ... . ... P256
Delete message. . ............. P259
Disconnect. .................. P195

Edit
Selectall ..................... P249
Sortbydate................... P258
Sort by sender/recipient. . .. ...... P258
Show subject. ................. P259
Email filters™. .. ................ P257
ZOOM .ottt P141
Preferences................... P260

* Some items may not be available depending on the operation.

*.

Displayed when a POP3 account is used.

W
<
Mitems available from the Menu bar on the message details screen
Tapping Message or Edit in the Menu bar displays items as shown below:
Message Edit
New ......... ... it P235 CopYy .o P249
Reply ... P245 Selectall ..................... P249
Replytoall................... P245 ZOOM .ttt P141
Forward ..................... P245 Preferences................... P260
Send attachment . ............. P250
Find ................... P247, P248
Findnext ............... P247, P248
Delete message. . ............. P259
Disconnect. .................. P195
* Some items may not be available depending on the operation.
A V|

NOTE

* Tapping information in message text (phone numbers, email addresses and URLs) allows you to easily make

phone calls, send messages or view websites.



Creating/Editing/Deleting Messaging Folders

l Creating Mailboxes I

Mailboxes can be created for managing messages, etc.

'I Tap Inbox" % Edit folders on the Menu bar in the message list
screen

*: The name of mailbox previously viewed is displayed.
* Tap [Cancel] to cancel the operation.

2 Tap Name and enter a name » Tap [Done]

* Up to XX double - or single-byte characters can be entered.
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Copying/Moving Messages to Another Mailbox

Messages can be copied/moved to newly created mailboxes with limitations as shown below.
O: copying/moving allowed A only copying allowed X : copying/moving not allowed

Source folder Destination folder
Inbox Unsent box Outbox Sent box Created folder
Inbox X A X A O
Unsent box X X X
Outbox X X X X X
Sent box X X X X O
Created folder X X X X O

¢ If an IMAP account is used, messages of which all data have not been received cannot be copied/moved.

'I Select $$ of the message to copy/move on the message list
screen

$$ is switched to $$.

Tap Message % Copy tolMove to in the Menu bar

* Tap [Cancel] to cancel the operation.

Buibessapy '
N

3 Tap Folder and select the destination folder » Tap [Done]

NOTE

¢ |f an IMAP email account is used/if the Delete from server (— P233) setting is enabled and a POP3 email
account is used
- If an email has been moved from the folder used when it was received, a screen is displayed to confirm
the deletion of the email with the identical contents that is on the mail server when connection is made to
the mail server on the next occasion. Be informed that tapping [Yes] makes the email unavailable for
retrieval.
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l Automatically Sorting Incoming Emails I

‘ This function is available when a POP3 is used. ‘

You can set rules for automatically sorting incoming mails into different folders.

'I Tap Edit ® Email filters on the message list screen

Priority: High

Priority: Low

* Tap $$/$$ to change the priority.

¢ Tap [Cancel] to cancel the operation.

2 Tap the name of the filter to change rules

Filter name: Specify the filter name.
* Up to 128 double or single byte characters can
be entered.
Move to  : Specify the destination folder.
Condition
Sender : Set this to sort emails by Sender. The sorting
conditions must be entered in Contains.
Subject : Set this to sort emails by Subject. The sorting
conditions must be entered in Contains.
Contains : Enter a text string as the sorting condition.
¢ Up to 256 double or single byte characters can

Buibessay .

be entered.
Operations
None : Select this to sort using one condition. The second
condition cannot be entered.
OR : Use this to sort emails that meet either of the two
conditions.
AND : Set this to sort emails that meet both conditions.

¢ Tap $$ to select them from the contacts.
¢ Tap [Cancel] to cancel the operation.

3 Tap the field for the item to set up » Tap [Done] after setting

M
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Rearranging Messages on List Screen

You can rearrange the messages displayed on the message list screen.

'I Tap Edit % Sort by datelSort by sender on the Menu bar in the
message list screen

Sort by date : Sort messages in chronological order.
Sort by sender: Sort messages in the order of name shown on the recipient/sender
address.

NOTE

* The sort order for Sort by sender is as described below:
Kanii (in the order of the JIS code) — hiragana — katakana ' — single-byte katakana — double-byte
alphabetical character 2 — single-byte alphabetical character 2 — double-byte numerals — single-byte
numerals — symbol (in the order of the JIS code)

*1:  If both hiragana and katakana are used, the order of the Japanese syllabary is given priority (ex.: &
ZWA -, ete.)

*2:  If both upper- and lower-case characters are used, lower-case characters come before upper-case
characters and the alphabetical order is given priority (ex.: aAbB..., etc.)

Switching Message List Screen View

The message list screen view can be switched to subject display.

'I Tap Edit » Show subject on the Menu bar in the message list
screen

The message list screen view is switched from a list to subject display.
* To restore the previous view, repeat the same operation.

Deleting Messages

Emails/SMS messages in inbox, outbox, unsent box, sent box, and created mailboxes can be
deleted.

You can delete messages by selecting them in the email list/SMS message list screen or delete
emails/SMS messages being displayed on the message details/SMS details screen.

'I Select $$ of the email/SMS message to delete in the email/SMS
message list screen
$$ is switched to $$.

2 Tap Message W Delete message in the Menu bar, and tap [Yes] on the
Confirm delete screen

The email/SMS message is deleted.
¢ Tap [No] to cancel deletion.



HlTo delete emails/SMS messages being displayed
Tap Message % Delete message on the Menu bar in the email details/SMS details screen, and
tap [Yes] on the Confirm delete screen

* Tap [No] to cancel deletion.
- W

NOTE

o |f the Delete from server (— P233) setting is enabled, on a POP 3 account, and an email has been deleted
from the folder used when it was received, a screen is displayed to confirm the deletion of the email with the
identical contents that is on the mail server when connection is made to the mail server on the next occasion.

Setting Messaging

l Setting Automatic Sending of Owner Card/Reply Quoted/Signature I

You can specify whether or not to automatically attach the owner card (— P114) and quote body
text to reply to messages, and what to append to message text as the signature. These settings
only function for the specified account.

* These settings are not available for Short Message Service (SMS).

'I Tap Edit % Preferences on the Menu bar in the message list screen

Always attach your card
: Specify whether or not to always attach your card to
messages.
$$ indicates use of automatic sending and $$ non-
use.

Always reply with history

: Specify whether or not to always quote body text of
the received messages to reply.
$$ indicates use of automatic quoting and $$ non-
use.

Signature : The entry made in this field is automatically
appended to the bottom of the body text of outgoing
messages.

* Up to 1024 double or single byte characters can
be entered.

2 Tap the field for the item to set up » Tap [Done]

NOTE

* Setting message ring tone — P123
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Creating and Sending SMS Messages

Create and send new SMS messages can be sent by FOMA handsets only.

'I Tap $$ » $$ on the Application Selector bar, and tap [New] in the
SMS message list screen

$$ : Set this up to receive receipts to show that messages
have been delivered to the recipients.
$$ Indicates receiving of receipts and $$ non-receiving.
$$ : Shows the size of SMS message
$$ : Brings you back to the account list screen.

2 Tap To and enter the recipient destination address

* Up to 20 single-byte characters can be entered.
* Specifying a recipient from the contact list = P238
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3 Tap the text field and enter text

¢ Up to 70 double- or 160 single-byte characters can be entered.
¢ Adding contact = P239

Tap [Send]
The SMS message is sent.

NOTE

¢ Text input method — P466
¢ Characters unavailable for use = P225
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Saving Unfinished SMS Messages for Sending Later

l Saving SMS Messages I

SMS messages in the process of creation or editing can be saved to unsent box.

'I Create a SMS message on the Create SMS screen » Tap $$

l Editing and Sending Saved SMS Messages I

Unsent SMS messages that have been saved can be sent.

Tap Inbox % Outbox/Unsent box in the menu list on the SMS
message list screen

*: The name of mailbox previously viewed is displayed.

Unsent SMS message
list screen

2 Tap the SMS message to edit
Go to Step 2 on P261.
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Automatically Receiving SMS Messages

When your FOMA handset is in-range, SMS messages are automatically delivered from the
Short Message Center.

'I A SMS message is delivered

The ring tone plays and the
screen as shown on the left is
displayed.

Tapping the circled area displays
the SMS message list screen,
allowing you to view received
SMS messages.

Home screen Other than Home screen

NOTE

* A Short Mail message sent from a mova i-mode handset is received as an SMS message on your FOMA
handset.
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Checking for Incoming SMS Messages

SMS messages delivered to the Short Message Center are automatically sent to the FOMA
handset. However, they are stored at the Center if the handset is switched off out of range.
Explicitly retrieving them delivers the SMS messages stored at the Center.

] Tap Message % Check for new SMS on the Menu bar in the SMS
message list screen

¢ Tap [Cancel] to cancel retrieval.

2 Tap [Done]
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Viewing SMS Messages Received

View received SMS messages and receipts of delivery (—P266).

'I Tap $$ in the Application Selector bar

2 Tap the account name ($$SMS)
3 Tap the SMS message to view

NOTE

¢ Any unviewable character (— P225) contained in a received SMS message is displayed as a space.
* A Short Mail message sent from a mova i-mode handset is received by a FOMA handset as an SMS
message. If the sender's phone number is not displayed, the reason for non-display is displayed.

Saving SMS Messages in UIM

SMS messages stored in the FOMA handset can be moved and saved to UIM. SMS messages

stored in the UIM can be moved to the handset.

'I Tap the SMS message to move on the UIM ($$)/SMS message to
move from the UIM ($$) on the SMS message list
$$ is switched to $$.

2 Tap Message % Move message to UIMIMove message from UIM on the
Menu bar

$$ indicates a SMS message in the FOMA handset.
$$ indicates a SMS message in the UIM.
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Performing SMS settings

| Default setting | Request acceptance: $8 SMS destination: Phone Memory Profile: SMS profile

Normally, the Profile name and SMSC address settings of Profile and Edit profile need not be
changed.

Set up conditions for using Short Message Service (SMS).

Tap $$ » $$ on the Application Selector bar, tap Connect tab »
Messaging account in the Control panel screen, and tap the SMS
tab in the messaging account screen.

Request acceptance
: Select this to request the sender to receive the
notification of delivery of a SMS message.
$$ indicates requesting and $$ not requesting.
SMS destination
: Select the destination of incoming SMS messages.
Profile: Select a profile.

r
M To edit a profile

[

Tap [Edit profile], tap the field for the item to set up in the SMS profile screen » Tap
[Done] after setting

Profile name : Set the profile name.

SMSC address: Set up the address of the SMS Center to connect
to. (If Profile name is SMS profilel, +81903101652 is
set.)

Save message : Specify how long sent SMS messages that are
undelivered will be stored at the Short Message
Center.

2 Tap the field for the item to set up » Tap [Done] after setting

* Tap [Cancel] to cancel setting.




Application

Installing an Application
Launching an Application
Uninstalling an Application
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Application

Applications such as games can be installed and used on a FOMA handset. Applications to be
installed can be obtained via the following methods.

* Obtaining applications from the Internet — P211

You can access the Internet and download compatible applications from websites before
installing them.

¢ Obtaining applications from a TransFlash memory card — P301

You can save applications to a TransFlash memory card in advance using a PC, etc., before
installing them by inserting it to a FOMA handset.

¢ Obtaining from a PC — P527

You can install the "Desktop Suite" to a PC from the accompanying CD-ROM and then install by
connecting the FOMA handset to the PC using a USB cable.

Installing an Application

Downloaded applications and applications saved to a TransFlash memory card can be installed
and be made available for use on a FOMA handset.

Tap $$ on the Application Selector bar and then tap Launcher %
Install on the menu bar

* Tap [Cancel] to cancel the operation.

Displays the name of the software.
Displays the location of the installation data.

2 Tap the application to be installed ¥ tap Install

¢ Tap [Cancel] to cancel the installation.
* Tap [Details] to display Signature information.— P269




Tap [Install] and then tap [Done] in the Installation confirmation
screen

Displays the application icon of the installed application on the Application Launcher.

r ~
HWhen an identical application is already installed
* Tap [Overwrite] to overwrite the existing application by the new
application.
¢ Tap [Cancel] to cancel the operation.
e 4

V=
M Application signature details

Tap [Details] in the Step 2 screen or Step 3 screen to verify

Application signature information.

[ |

NOTE

¢ The confirmation screen is displayed when unwarranted software for use in FOMA handset is installed.
Warranty is not guaranteed once installed.
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Launching an Application

You can launch an installed application from the Application Launcher screen.

'I Tap $$ on the Application Selector bar

The icon of the installed application is added.

2 Tap the icon of the application to be launched

Uninstalling an Application

This operation uninstalls an already installed application. Be cautioned that software once
uninstalled cannot be used thereafter.

Tap $$ on the Application Selector bar and then tap Launcher %
Uninstall on the menu bar

¢ Tap [Cancel] to cancel the uninstall.




2 Tap [Uninstall]

3 Tap [Yes] and then tap [Done] on the Uninstall confirmation
screen

The application is uninstalled.
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